
INDIANA DEPARTMENT OF TRANSPORTATION 
   

 

INDOT Production 
Surveys 

 

V8 XM Edition 



  

 

 ii

 
Acknowledgement 

 
This manual and the INDOT Workspace was the combined efforts of many contributors, 
far too numerous to mention each by name.  Just to mention a few, the CADD Team, 
Planning & Production Applications Section of INDOT, Donald Mohid, Danny 
Greenberg, Survey Operation Managers, and any of the other users providing help, 
testing, and feedback.   
Many thanks to all for this invaluable help – Scott Robison. 
 
 
 
 
Authors 
 
Derek Fuller 

Chris Martin (Bentley Systems Inc.) 
 
Greg Carrie 
Lora Crall 
Jason Kuhn 
Scott Robison 
 
 
Updates 
 
This manual has been created with point page numbering allowing updated pages to be 
inserted while removing out of date documentation. 
 
As updates become available, please replace the existing pages. 
 
 



CAD Support Help Site  Accessing CAD Support Help Site

 

 
INDOT Production – Surveys  

 iii 

 

Table of Contents 

Chapter 1 - CAD Support Help Site ........................................................................ 1.1-1 
1.1 Accessing CAD Support Help Site........................................................................ 1.1-1 
1.2 Site Layout & Terms.............................................................................................. 1.2-4 
1.3 The Home Page ...................................................................................................... 1.3-8 
1.4 The INDOT Intranet.............................................................................................. 1.4-9 
1.5 CAD Training Calendar...................................................................................... 1.5-10 
1.6 The Digital Classroom ......................................................................................... 1.6-14 
1.7 Employee Training Schedule .............................................................................. 1.7-18 
1.8 The FAQ Page ...................................................................................................... 1.8-20 
1.9 Help Requests ....................................................................................................... 1.9-22 
1.10 Training Database.............................................................................................. 1.10-24 

Chapter 2 - MXRoadmax MicroStation................................................................ 1.10-1 
2.1 Licensing Changes of Bentley XM products........................................................ 2.1-1 
2.2 What’s New in MX XM......................................................................................... 2.2-1 

2.2.1 Release Notes ................................................................................................................... 2.2-1 
2.3 Keeping MX Up to Date ........................................................................................ 2.3-2 

2.3.1 Update MX Files .............................................................................................................. 2.3-2 
2.3.2 Files Updated from the Network ...................................................................................... 2.3-3 

2.4 Getting Started ....................................................................................................... 2.4-4 
2.5 Menu Customization.............................................................................................. 2.5-8 

2.5.1 Initial customization ......................................................................................................... 2.5-8 
2.5.2 Switching between MX Menus and MicroStation (CAD menu) .................................... 2.5-10 
2.5.3 MX/CAD Focus.............................................................................................................. 2.5-11 
2.5.4 User Preferences ............................................................................................................. 2.5-13 
2.5.5 Right Click / Reset – Right Press and hold operations ................................................... 2.5-15 

2.6 CAD Menus and Toolbars................................................................................... 2.6-17 
2.6.1 Menu Layout .................................................................................................................. 2.6-17 
2.6.2 Task Navigation.............................................................................................................. 2.6-17 
2.6.3 Positional keyboard Mapping ......................................................................................... 2.6-21 
2.6.4 Dialog Focus................................................................................................................... 2.6-22 
2.6.5 View toolbar ................................................................................................................... 2.6-23 
2.6.6 Mouse Operations........................................................................................................... 2.6-24 
2.6.7 Missing buttons and Toolbars......................................................................................... 2.6-25 
2.6.8 Button Bar ...................................................................................................................... 2.6-25 
2.6.9 Save Settings .................................................................................................................. 2.6-25 

2.7 Seed Files............................................................................................................... 2.7-26 
2.8 Running Input Files ............................................................................................. 2.8-27 



CAD Support Help Site  Accessing CAD Support Help Site

 

 
INDOT Production – Surveys  

 iv 

 

2.9 Creating Survey Base Drawings ......................................................................... 2.9-30 
2.10 Rotate Drawings 3D........................................................................................... 2.10-31 
2.11 Shading Triangulation Surfaces ....................................................................... 2.11-36 
2.12 Ending your MX Session ................................................................................... 2.12-38 
2.13 Closing MX manually ........................................................................................ 2.13-38 

Chapter 3 - Route Plat Sheet Creation.................................................................. 2.13-1 
3.1 The Route Plat MicroStation File......................................................................... 3.1-1 
3.2 What’s New in MicroStation XM ......................................................................... 3.2-2 

3.2.1 Tasks................................................................................................................................. 3.2-3 
3.2.2 Design History.................................................................................................................. 3.2-5 
3.2.3 INDOT – INFO ................................................................................................................ 3.2-8 
3.2.4 MicroStation Models ........................................................................................................ 3.2-8 
3.2.5 Annotation Scale............................................................................................................... 3.2-9 

3.3 Contents of the Template Route Plat dgn File................................................... 3.3-13 
3.4 Creating Reference Boxes ................................................................................... 3.4-14 
3.5 Creating Reference Point Coordinate Table ..................................................... 3.5-30 
3.6 Creating Route Plat Sheets.................................................................................. 3.6-33 
3.7 Adding DGN Files to the Route Plat .................................................................. 3.7-36 
3.8 Adding Ref. Boxes to Route Plat......................................................................... 3.8-41 
3.9 Adding a Coordinate Table to the Route Plat ................................................... 3.9-46 
3.10 Creating Section Corner Cards ........................................................................ 3.10-50 

Chapter 4 - Plotting ............................................................................................... 3.10-1 
4.1 Plotting in MicroStation XM Using Print/Plot .................................................... 4.1-1 
4.2 Plotting to a PDF file in MicroStation XM Using Print/Plot.............................. 4.2-4 
4.3 Plotting Configuration........................................................................................... 4.3-7 

4.3.1 Printer/Plotter locations: ................................................................................................... 4.3-7 
4.4 Adding Printers and Plotters ................................................................................ 4.4-8 

4.4.1 Print/Plot Drivers.............................................................................................................. 4.4-8 
Chapter 5 - ProjectWise and the Survey Workspace.............................................. 4.4-1 

5.1 Creating a New Survey Project............................................................................. 5.1-1 
5.2 Adding a Completed Project to ProjectWise....................................................... 5.2-5 

5.2.1 Starting ProjectWise ......................................................................................................... 5.2-5 
5.2.2 Accessing the INDOT Datasource.................................................................................... 5.2-6 
5.2.3 INDOT Folder Structure................................................................................................... 5.2-8 
5.2.4 Importing the Project into ProjectWise........................................................................... 5.2-10 

5.3 Pick-Up Surveys and ProjectWise...................................................................... 5.3-14 



CAD Support Help Site  Accessing CAD Support Help Site

 

 
INDOT Production – Surveys  

 v 

 

5.3.1 Exporting the Existing Project from ProjectWise........................................................... 5.3-14 
5.3.2 Importing the Completed Pick-Up Project into ProjectWise.......................................... 5.3-17 

5.4 Reference Scanning.............................................................................................. 5.4-17 
Appendices.......................................................................................................................... 1 

Appendix A - INDOT Survey Project Lifecycle In ProjectWise........................................... 1 
Appendix B - Naming Conventions ......................................................................................... 1 

B.1 Model Names ................................................................................................................................. 1 
B.2 General practices ............................................................................................................................ 2 
B.3 Model Names and Style Set Association........................................................................................ 3 
B.4 Input Files Names........................................................................................................................... 4 
B.5 MicroStation Drawing Names........................................................................................................ 5 

Appendix C - Drawtopo.inp ..................................................................................................... 1 
C.1 Drawtopo input file ........................................................................................................................ 1 

Appendix D - Triangle.inp........................................................................................................ 1 
D.1 Triangulation Input File ................................................................................................................. 1 

Appendix E - Sections.inp ........................................................................................................ 1 
E.1 Cross Sections Input File................................................................................................................ 1 

Appendix F - create_survey_base_drawings.inp.................................................................... 1 
F.1 Create Survey Base Drawings Input File........................................................................................ 1 

Appendix G - Level Libraries .................................................................................................. 1 
Appendix H - MicroStation Libraries ..................................................................................... 1 

H.1 DGN Library .................................................................................................................................. 1 
H.2 Text Styles ..................................................................................................................................... 1 
H.3 Dimension Styles and Settings....................................................................................................... 2 
H.4 Models............................................................................................................................................ 4 
H.5 Attaching references .................................................................................................................... 10 
H.6 Levels and Level Filters ............................................................................................................... 18 
H.7 Design File Settings ..................................................................................................................... 20 
H.8 Structure of a V8 Design File....................................................................................................... 26 
H.9 Cell Libraries................................................................................................................................ 27 

Appendix I - Sheet use .............................................................................................................. 1 
I.1 INDOT Border / Sheet Models........................................................................................................ 1 
I.2 Sheet Name and Sheet Description.................................................................................................. 2 

Appendix J - Scale Chart.......................................................................................................... 1 



CAD Support Help Site  Accessing CAD Support Help Site

 

 
INDOT Production – Surveys  

 vi 

 



CAD Support Help Site  Accessing CAD Support Help Site

 

 
INDOT Production – Surveys  

 1.1-1 

 

 

Chapter 1 -CAD Support Help Site 

1.1 Accessing CAD Support Help Site 
The purpose of this section is to provide a navigational tour of the CAD Support Help 
Site.  On the typical desktop there are many different ways to access the CAD Support 
Help Site. The following instructions go through two of the most common methods: 

   

The first way to access the Help Site is by clicking on the CAD Support 
Help Site icon on your desktop.  This will take you directly to the CAD 
Support Help Site.  
 

 
The second way to access the Help Site is by clicking on the INDOT 
Application Support icon on your desktop.  This will take you to the start 
page of the Help Desk Page.  It is from here that you navigate to the CAD 
Support Help Site. 
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First navigate to the Team Site page by clicking on the CAD Support Help Site tab, 
located along the top left of the start page. 

 

 
 
Second navigate to the CAD Support Help Site by clicking on either the CAD Help 
Site tab, located along the top left of the Team Site page. 

 

 
 

 

Or by clicking on the Indiana CAD graphic 
icon in the middle of the page. 
 
 
 
 



CAD Support Help Site  Accessing CAD Support Help Site

 

 
INDOT Production – Surveys  

 1.1-3 

 

You will be directed to the CAD Support Help Site 
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1.2 Site Layout & Terms 
To help you better follow this document, we will first discuss some terms that will be 
used to describe the layout of the CAD Support Help Site. 

 

 

 

 

1. The Main Body of the site is the largest area of the document. 

2. The Right Side of the document is actually part of the body, but will contain 
additional information. 

3. The Quick Launch area is located to the left of the main body and will contain 
links to other sections of each area. (Training Database, Team Discussion) 

4. The Top Link Bar will be used to navigate to each area of the CAD Support Help 
Site. 

1 
3 

4

2 
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The Main Body of the home page consists of four parts. 

• A direct link to the INDOT Help Desk, which will be discussed later in this 
chapter. 

 

• A listing of Announcements – Events and happenings which describes any 
newsworthy changes or additions within the CAD Support Help Site, or the CAD 
Support Group. 

 

• A listing of the CAD Contacts within the CAD Support Group. 

NOTE:  PLEASE DO NO CONTACT THE CAD SUPPORT GROUP DIRECTLY 
UNTIL A HELP DESK TICKET HAS BEEN FILLED OUT! 
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• A quick link listing of the FAQ document folders is located below the CAD 
Contacts as shown below: 

  

 

The Right Side of the home page consists of three parts. 

• A direct link to the CAD Training Calendar, which will be discussed later in 
this chapter. 

 

 
• A list of Important Links which will open new pages while allowing you to stay 

on the CAD Support Help Site. 
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• A user specific list of our Training Database, will be displayed in the lower right 
corner with all CAD related classes you have taken while at INDOT. (Updated 
monthly)  This will also be covered in section 1.10. 
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1.3 The Home Page 
The Home Tab (Top Link Bar) will return you to the main page whenever selected. 

 

 

 

 



CAD Support Help Site  The INDOT Intranet

 

 
INDOT Production – Surveys  

 1.4-9 

 

 

1.4 The INDOT Intranet 
The INDOT Intranet Tab (Top Link Bar) will take you to the INDOT Intranet home 
page. 
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1.5 CAD Training Calendar 
The CAD Training Calendar (Top Link Bar) will take you to a Calendar listing of all 
INDOT CAD events, including Training Classes. 

 

 

 



CAD Support Help Site  CAD Training Calendar

 

 
INDOT Production – Surveys  

 1.5-11 

 

 

The information contained in the Quick Launch portion of this site will be discussed in 
the “Employee Training Schedule” portion of this chapter. 

 

Each event listed on the calendar is linked to a class information page consisting of the 
following. 

• Course Title 

• Course Description, which includes a link to the Digital Classroom assigned to 
the class. 

• Instructor (If multiple instructors are scheduled, then the main instructor) 

• Location (Physical location, where the class will be conducted) 

• Available Seats (The number of remaining seats available for that class) 

• The start and end times of that class. 

• My Registration Button. (used when registering for class listed) 

• Course Registration List. (Will show who has registered for the class.) 
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To register for a class, first determine if there are seats available, and then click one of 

the   buttons located above and below the course description. 

This will take you to the Course Registration page which gives you the following 
information. 

• Whether you have or have not previously registered for the class 

• Attendee (your name) 

• Course Title 

• Start Time 

• End Time 

 

To complete registration for the class, click either of the buttons located 
above and below the registration information.  You will then be returned to the Class 
Information page and your name should appear in the Course Registration list. 

Upon successful registration for the course, you will receive a confirmation via email 
from Sharepoint@iot.in.gov telling you that you have successfully registered. 

PLEASE DO NOT RESPOND TO ANY EMAIL FROM THIS ADDRESS. 
If you decide that you do not yet want to register for this class, click either of the 

buttons located above and below the registration information.  You will 
then be returned to the Class Information page and your name should not appear in the 
Course Registration list. 
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If the course is full when you click on the  button, you will be taken 
to a “Class is full” notification page.   

 
Clicking on the text that says Click here to return will direct you to the Training 
Requests area which will be covered later in this document. 
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1.6 The Digital Classroom 
If you wish to view a more detailed description of the class listed, click on the link to the 
Digital Classroom, which is located in the Course Description area on the class 
information page. 

 

The Digital Classroom is laid out as follows.  
 
The main body of the Digital Classroom contains. 
Class Location, Day(s) and Time 
A link to the data sets for that class 
Student and Instructor Surveys (Not to be completed until AFTER completion of the 
class) 
 
The right side of the Digital Classroom contains. 
A list of all instructors scheduled for that class. 
A daily agenda for that class. 
 
The Quick Launch Bar provides the following links to additional portions of the Digital 
Classroom. 
Course Syllabus 
Student Information 
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The Course Syllabus link, located in the 
Quick Launch Bar takes you to a detailed 
look at the class listed.   
 
 
 
 

 
 
If the class covers more than one topic (See Unified Workspace Rollout) the course 
description will be provided, but you will have to click on the Course Title to view the 
complete syllabus.  (See next page for illustration) 
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From within the Digital Classroom, the CAD Support Home Page tab (Top Link Bar) 
will return you to the CAD Support home page. 

 



CAD Support Help Site  Employee Training Schedule

 

 
INDOT Production – Surveys  

 1.7-18 

 

 

1.7 Employee Training Schedule 
The Employee Training Schedule Tab (Top Link Bar) will take you to the Employee 
Training Schedule area. 

 

 

This area is specific to the user and can be used as a base to track any classes that he or 
she is scheduled to take or has taken in the past.  This area can also be used to quickly 
navigate to the Training Class Calendar. 
 

 
 
 

5. Courses I am attending: This area will automatically track all of your upcoming 
training classes.  As long as you are viewing the site while logged into the DOT 
domain as yourself, this should show only the classes that you have signed up for. 

5 

6 

7 

8 9 
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6. Courses I have attended: This area will automatically track all of the training 

classes that you have attended.  As long as you are viewing the site while logged 
into the DOT domain as yourself, this should show only the classes that you have 
signed up for. 

7. Course Data Sets:  Located in the Quick Launch Bar, will take you to all data 
sets associated with any training class given by the Bentley or the INDOT CAD 
Support Group.  These are stored on an INDOT server as executable files.  You 
simply double left mouse click on the file to store the file on your local machine. 

8. Related Training Links: Contains a list of direct links to the BLN and Bentley’s 
Tech Notes and FAQ Page 

9. Announcements:  Contains any announcements pertaining to the employee’s 
training needs 

 
 

The CAD Training Calendar link, located in the Quick Launch Bar, takes you to the 
Training Class Calendar, which has been discussed previously in this document.   
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1.8 The FAQ Page 
The FAQ Tab (Top Link Bar) will take you to the Frequently Asked Questions Page. 
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Once a category is selected the user will be taken to a page with .pdf documents 
containing information about that topic. 
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1.9 Help Requests 
The Help Requests Tab will take you to a New Help Ticket form. 

 

 

There is also a Help Request button on the Home page that will take you to the New Help 
Ticket form. 

 

This is the form you will be presented with when selecting the new ticket link.  The 
information this form requests is needed to aid the Application Support Staff in 
contacting you and providing an answer in a timely fashion.  
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A brief explanation of the fields: 

LAN Login ID: Enter your LAN userID (See note directly below the logon box for 
further instructions on the ID required) or enter your full name in the following format: 
Smith, Joe.  If you enter your full name it must be entered just as it is in the address book 
in Outlook. You can click on the address book and search for your name. If the user as 
keyed is not found, the field will not accept the input and signify this by underlining the 
field in red. 

Phone Number: This field is for the entry of your phone number. 

Location: This field is for the entry of your office location. (District/Central 
Office/Other) 

Room Number: This field is for the entry of your location in the event on-site support is 
required. 

Division/Company: Enter your agency/district/sub/unit.  Non-INDOT users: Please enter 
the name of your company 

Computer Name: This field is for the entry of your computer name.  (See note directly 
below the computer name box for further instructions on how to gather this information) 

Application/Service: This field is for the entry of the Application/Service that you 
require assistance with. 

Issue Type: This field is for the entry of the type of issue you are having, such as 
software installs and application issues. 

File Path: This field is for the entry of the path to the file you require assistance with if 
applicable. 

Description of Problem: This field is for the entry of any relevant details as to what your 
issue may be. 

As is noted on the form, many of these fields are required to assist the support staff in 
contacting you, and providing a complete picture of the issue.  The more information that 
you provide us, will better enable the support staff to resolve your issue in a timely 
fashion. 

 

Upon completion of the form, select the OK button and your ticket will be submitted.  
Once you have submitted the help request you will receive an e-mail confirmation, from 
the helpdesk, that a ticket has been submitted and a member of the application support 
staff will be contacting you.  During the process of working on your ticket, you will be 
notified of various status changes, and be able to view the status of your ticket via e-mails 
sent, updating you on status changes. 
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1.10 Training Database 
 

 

 

 

The Training Database link on the left side of the 
Home Page will provide each user a list of all CAD 
classes they have taken while at INDOT. 
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Chapter 2 -MXRoadmax MicroStation 

2.1 Licensing Changes of Bentley XM products 
Licensed applications no longer require constant connections to Select License Server.  
This is to ensure users that they are not denied from using their applications.  The 
applications do need to connect once per 30 days.  This means the application only needs 
to run once per thirty days connected to the network to maintain the license.  Every time a 
connection is seen, users automatically get 30 more days before the next connection is 
necessary.  Users no longer need to explicitly check out a license. Users also have the 
added benefit of having access to be able to run more simultaneous instances of an 
application than they currently own. 
 

2.2 What’s New in MX XM  

2.2.1 Release Notes 
MX in Windows has been replaced by MX Stand-alone.  This MX version includes a 
totally self-contained, high quality CAD functionality. This stand-alone version of MX 
uses Bentley PowerDraft for its CAD engine.  PowerDraft is a near fully functioning 
version of MicroStation without some advanced features. 
 
MX now uses native CAD functionality for Pan, Zoom, and other functions previously 
available from the MX Zoom toolbar.  Also, it uses native CAD functionality for Views 
and multiple Viewports.  These functionalities are now provided by tools within the 
MicroStation environment. 
 
The Model Navigator is a new tool used to review wireframe and rendered surfaces; and 
dynamically manipulate the relationship of the camera and the model being viewed. 

The MX Online Help has updated Linemode and Reference sections which now include 
information from the MX Command Language Reference.  These documents have also 
been reorganized to be more task oriented.  Included in these documents are the help 
documents for MXRENEW, MXURBAN, MXRAIL and MXSITE; along with Getting 
Started and tutorials for MXROAD. 

Macrosymbols displayed by MX as Cells can now be unlocked to manipulate the 
individual cells (scale/rotate etc). 

Due to the expansion of the modelfile at this release, any modelfile created using the XM 
Edition cannot be opened with an earlier version of the product.  To open an XM Edition 
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model with an earlier version of the product export the model information in GENIO 
format and then re-import this into the older version 

The previously listed items are from the Release Notes of this version of MX.  For 
complete details of the changes in this version, please refer to the Release Notes 
documentation that is found within the online help. 
 

2.3 Keeping MX Up to Date 

2.3.1 Update MX Files 
There is a batch file named Update MX Files.bat, which must be run prior to using 
MXROADMAX MicroStation.  This batch file updates all local files required by MX.  
The network versions of these files are the most up to date and will be copied locally.  
Browse to X:\INDOT Extras XM and select the Update MX Files.  Also, a shortcut to this 
file will be placed upon the desktop. 
 

 
 
It will run a script that updates the files. Upon completion the script will alert the user 
that the files have been copied, and will dismiss itself after a few seconds. 
 
On occasion an email will be sent out notifying the users to run this batch file.  Upon 
receipt of the email all users that have made changes to any of the files that are about to 
be updated can rename and move them to a location on the network in their project 
folder. 
 

 
In addition to update information sent via email, users can optionally run this macro 
weekly to ensure you have the latest versions of all required files. 
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2.3.2 Files Updated from the Network 
The following is a summary of all the files which are copied locally via the batch 
executable from various network locations as shown below grouped by location: 
 

• MX Macro Lines, MX Macro Symbols, and MX Command Macros 
Metric:   X:\INDOT Extras XM\mfw\US_Macros\ to C:\Program 
Files\Bentley\MX\mfw\US_macros\ 

Imperial:  X:\INDOT Extras XM\mfw\us_imperial_macros\ to C:\Program 
Files\Bentley\MX\mfw\us_imperial_macros\ 

• MX Feature & Style Sets, MX Page Setup Files, MXDRAW annotation Tip 
Files, MX Masking tables, MX drawing input files, MicroStation Border 
Drawings for MX created sheets 

Metric:   X:\INDOT Extras XM\mfw\US_Styles\ to C:\Program 
Files\Bentley\MX\mfw\US_styles\ 

Imperial:  X:\INDOT Extras XM\mfw\US_imperial_styles\ to C:\Program 
Files\Bentley\MX\mfw\us_imperial_styles\ 

• MicroStation Seed files for MX created drawings, and MX INDOT Cell 
library 

X:\INDOT Extras XM\mfw\MfM\Seed \ to C:\Program 
Files\Bentley\MX\mfw\mfm\Seed\ 

• MX .dat files which control the behavior and mapping of symbology from MX to 
MicroStation for: MX font to MicroStation font, MX macrolines to MicroStation 
linestyles, MX macrosymbols to MicroStation Cells, and MX pen width to 
MicroStation line weight. 

Metric:  X:\INDOT Extras XM\mfw\MfM\Data\ to C:\Program 
Files\Bentley\MX\mfw\mfm\Data\ 

Imperial:  X:\INDOT Extras XM\mfw\MfM\Imperial_Data\ to C:\Program 
Files\Bentley\MX\mfw\mfm\imperial_data\ 

• Defmods.txt (the model to Feature set & Style set association file) and the MX 
Color Palette 

X:\INDOT Extras XM\mfw\US_sys\ to C:\Program 
Files\Bentley\MX\mfw\US_sys\ 
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2.4 Getting Started 
 
 
First you will need to start MX XM by double clicking on the MXROAD 
Suite MicroStation icon on your desktop.  This will take you to the Start Up 
screen for MX. 

 

 

For a new project, select the New Project button, key-in the Project Name, browse to the 
appropriate folder location, and select the desired system for the unit of measure, then 
select OK. 

For an existing project, select the Open Project button, then browse to the appropriate 
folder location and select the desired Project Name, then select OK. 
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The Non-tangential Alignments Information box will pop-up.  You can check the 
appropriate box if you do not want to see the panel again or you decide not to use Non-
tangential Alignments, otherwise select OK.  

 

Next the String Naming Convention Information box will pop-up.  Make sure the String 
Naming Convention box is checked, and select OK. 

 

At this point MXROADMAX MicroStation will open/start the desired project.  Typically 
the draw.dgn file will be the default CAD file.  You can create a new display file by 
selecting File->New Plan Display at the top left. Or you can open an existing display file 
by selecting File->Open Display/Drawing at the top left. 
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The MX Menus: 

 
 
The MicroStation / PowerDraft Menus: 

 
 
To change between the two menu systems you will need to select the applicable item in 
the above menus.  For the purposes of this manual, it is assumed that the MX menu is the 
active menu at all times. 
 
MX menu to MicroStation menu procedure: 
With the MX menu active, select File -> CAD Menu. 
 
MicroStation menu to MX menu procedure: 
With the MicroStation menu active, select MX -> MX menu. 
 
As with the prior releases of MX, the full functionality of the MX menu is embedded 
within the MX dropdown option when the MicroStation menu is active. 
 
Note:  The MX in MicroStation project can be closed, other projects can be opened, or 
the user has the option to return to the same project by: File -> Close Project 
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MicroStation stays open, and you can then open a MX project again by choosing MX -> 
Open Project. 

 

 

Excercise  2.4.1 : Create a new MX Project 

1. Start MXROAD Suite MicroStation. 

2. If the Tip of the Day pops up left click on Ok. 

3. Navigate to the appropriate location. (C:\Projects\Training\Project Files) 

4. Type in a Project Name. (9999999_SRXX) where XX is your student number 

5. Make sure the Default Project Settings are US_Imperial. Then left click on Ok.  
Below is an example for Student_01. 
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6. Left click on Ok in the Information panel. 

7. Left click on Yes in the Create Project panel. 

8. Left click on Ok in the String Naming Convention panel. 

 

2.5 Menu Customization 

2.5.1 Initial customization 
Toolbar placement 

Additional Menu Structure / Toolbars appear when you first enter MX in MicroStation. 
Several default toolbars appear which can be positioned as desired.  All of these tool bars 
are now Dock able! 
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Changes made to the location of toolbars are recorded in each user’s user preference file.  
The preferences are unique to each specific application, (i.e. changes made in MX in 
MicroStation, do not appear in MicroStation). 

 

Position toolbars as needed: 

 

Toolbars are as follows 
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A sample arrangement could look like the following: 

 

 

2.5.2 Switching between MX Menus and MicroStation (CAD 
menu) 

 
The default arrangement for menus is to have the MX menus across the top of the 
Application window.   

 

 
 
Access to Cad Menus is achieved by selecting File -> Cad Menu 
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Selecting CAD Menu will change the top application options to the following 

 

 
 
 

2.5.3 MX/CAD Focus 
With the movement of MX into a MicroStation/PowerDraft based CAD engine, the 
importance of MX/CAD focus has new meaning.  The focus is controlled in this toolbar: 
 

 
 

Many shortcut keys and options are controlled by similar combinations in both MX and 
MicroStation.  In order to differentiate between the two functionalities, the MX Controls 
toolbar has the MX/CAD Focus option in the leftmost drop down.   
 
When performing MicroStation native functions such as referencing, or a save settings 
(via Ctrl+F shortcut combination) you will need to set the value for this option to CAD, 
this will allow the full array of function to be available for these items.  Selecting MS 
buttons will change focus to Cad.   Generally the same can be said for selection of MX 
buttons changing focus to MX.   MX functions such as running an input file (via Ctrl+I 
shortcut combination) will require this to be set to MX in order to function.  Some MX 
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commands such as invoking either of the Quick Alignment options will automatically 
cause the focus to change back to MX. 
 
This is also important when viewing tooltips for various graphic elements.  When set to 
CAD, the item will show its MicroStation native tooltip which includes object type, 
description and level name.  With it set to MX, the tooltip will be the MX standard tooltip 
which presents information such model name, string name, bearing, etc. 
 
As a suggestion, it’s recommended that you setup a MicroStation hotkey combination in 
order to quickly switch your Focus on the fly.  In order to setup this functionality go to 
the following menu option CAD Menu -> Workspace -> Function Keys and create a 
shortcut key combination as illustrated.  The command you will want to append to your 
combination is “mx focus”. 
 

 
 

This will allow you to quickly swap focus without having to select the focus dropdown 
while performing other functions. 
It is suggested to use a Function combination that is not already used for other 
commands, such as the one shown in the illustration above. 
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2.5.4 User Preferences 
 
Changes to the general appearance of MX in MicroStation are controlled from 
Workspace -> Preferences. 
 
By the selecting the look and feel category of Preferences, users may customize 
the visual aspects of the application.  For example: Tool sizes can be adjusted, 
making icons more visible.  
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View tool size may also be adjusted 

 

 
Default Fonts can also be adjusted…(default is size 9) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Numerous Other Adjustments can be made as well.  Experiment with 
 

1. Borderless Icons 
2. Increase contrast of icon edges 
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2.5.5 Right Click / Reset – Right Press and hold operations 
 
The First time a User Right clicks 
in MicroStation they will be 
presented with options about how 
they would like MicroStation to 
behave. 

 
We suggest selecting the 
(MicroStation Default) 
 
Similar to most Microsoft windows applications, where right clicking gives users options, 
MicroStation has been enhanced to provide this functionality. 

Numerous options are available by pressing and holding the Rt 
mouse button.  The options that display are dependent on the 
elements that the cursor is over at the time the command is invoked. 

 
The idea is to give users access to commands without navigating to 
docked toolbars.  
 
Operations normally accessible from the manipulate toolbar are 
available (ie. Copy, move, etc.) 
 
Rt clicking also gives access to selection options (select all, select 
none, and select previous). 
 
Cut, copy, and paste to clipboard would be useful to access the 
windows copy paste functionality in CAD. 
 
Delete is available as well as Element Properties. 
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When Rt press hold is performed over Reference files,  
 
By selecting Exchange the application will leave the current 
file and will open the associated reference file. 
 
When the Edit Reference is selected, a second MicroStation 
session will be opened allowing the associated reference file 
to be edited. 
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2.6 CAD Menus and Toolbars 

2.6.1 Menu Layout 
Previously, the main tool frame, located in the upper left had two columns of icons.  
These have been separated into two distinct areas.  The Main tool box, shown below, 
includes tools for selection, modification, etc, but not related to creation. Creation tools 
are located elsewhere. 
 
Main Tool              Task 
     Box           Navigation 

 
 
Notice the small numbers  
in the lower left corner of each icon. 
These are known as Positional Aids 
 
 
 
     Task Navigation toolbar 
     is including all of the 

                                                tools related to creation 
     ( ie. Lines, blocks, text, 
                                                                dimensions, etc.). 
 
         
 
 
 
 

 

2.6.2 Task Navigation 
Task Navigation is simply a logical grouping of tools.  Rather than having numerous 
toolbars in various locations, a task is a collection of the tools you need all on one toolbar 
for a given task.   
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Task Navigation can be displayed horizontally as well as the default vertical.  As with 
other tool bars in MicroStation, tools can be stretched and reoriented.  The default 
placement for this toolbar is on the right side of the MicroStation window displayed 
vertically. 
 
Note: Tasks icons have Letters in the lower left corner. 

 

The task list icon allows users to select the appropriate task.   

 

The default tasks are drawing and drawing composition.  Since some tasks require the 
same tools, tasks can include some of the same tools. 

 
 
 
 
 
<PgUp> : will go to the next task in the task list 
 
<PgDown> : will go to the previous task in the  

           task list 
 
The task list can be expanded where the plus symbols exist. 
 
Certain tasks are subs to other tasks as illustrated below. 
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The resulting toolbar would look as follows. 

 

 
Hint: Simplification of Tasks can be achieved by changing how tasks are displayed in 
the user preferences.  Users who are new to MicroStation and or PowerDraft may not 
know what an icon is indicating.  This modified view shows the icons in conjunction with 
text describing the tools. 
 
To implement this change, users should select from the Cad menu. Workspace -> 
Preferences -> Category -> Task Navigation -> Task Navigation Preferences – 
Presentation -> Dialog. 
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Resulting Task Navigation dialog, 
 

 
 
 
 
 
 
 
Sub items can select when the expand arrow exists. 
 
Open as toolbox allows users to work as with previous versions of MicroStation. 
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2.6.3 Positional keyboard Mapping 
Positional mapping allows users to access commands by selecting the items from the 
Keyboard.  The keyboard is divided into zones to group access to commands. 
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2.6.4 Dialog Focus 
MicroStation manages the inputs from users for positional mapping by managing the 
focus (or part of MicroStation you are currently interacting with)  Feedback is provided 
to the user on the MS status bar in the lower right.  Focus is indicated with the following 
icons: 
 

                    
 Home focus,  tool settings window,   Key-in,       AccuDraw 
 
When at home focus the keyboard key selected corresponds to the tool selected.  Home 
focus also allows tools to be changed.  To return to home focus Press Esc 
When placing and element, focus may move to tool settings(as settings are changed), to 
accudraw (as precision input is provided) during placement, and then to home. 
 
Access Tools in the Main Toolbox with Positional mapping. 
With focus at home, pressing a number will access the main tool box.  For Example 
selecting 3 will open a menu at the current cursor location listing the manipulate tools.  
Pressing a second number, let say 1 will access copy.  Remember Esc returns dialog 
focus to home.   
Some examples of the sequence would be 
Esc -> 3 ->3   Scale 
Esc -> 7 ->1   Modify element 
Esc -> 4 ->4   Window Area 
  
Access Tools in Task Navigation with Positional mapping. 
With focus at home, pressing a letter will access the task toolbox.  For Example selecting 
Q will open a menu at the current cursor location listing the  tools.  Pressing a second 
entry, let say 2 will access Place line.  Remember Esc returns dialog focus to home.   
Some examples of the sequence would be 
Esc -> Q ->1   Place Smart line 
Esc -> A ->1   Place Text 
Esc -> D ->5  Measure Area 
 
Tips: <space> Switches focus to AccuDraw 
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2.6.5 View toolbar 
The view toolbar has been repositioned at the top left of the View window.  The default 
view toolbar for 3D drawings has the following icons. 

 

1. View Attributes. Used to select, control and change the type of elements and 
graphic attributes in the information displayed in the view.  

2. Saved Views. Used to name, save, delete, import, apply and recall saved views. 
Saving a view allows you to quickly recall a view with specific attribute settings. 

3. Zoom In. Increase the magnification of a view. 
4. Zoom Out. Decrease the magnification of a view. 
5. Window Area. Use to magnify an area of the display, in the selected view. 
6. Fit View. Used to fit the entire display in a view. Further specific options are 

available: 
7. View Rotation. Used to rotate the display in a view. Select from Top View or one 

of the other nine variations of rotation available from the fly-out tool bar. 
8. Rotate View 2D. Use to rotate or maneuver a display in a progressive and 

dynamic way, within a view. 
9. Pan view. Used to move (pan) the display without changing the view 

magnification. Move the display under the cursor by holding the left mouse 
button down and moving the cursor around the screen.  

10. View Previous. Cancels the last view control operation and returns you to the 
previous view. 

11. View Next. Applies the last undone view control operation. 
12. Clip Volume. Clips a view so no elements outside a defined boundary are visible. 
13. View Attributes. Used to select, control and change the type of elements and 

graphic attributes in the information displayed in the view. 
14. Change View Perspective. Change the perspective angle of a 3D view. 
15. Model Navigator. This tool allows you to review a wireframe or rendered surface 

and dynamically manipulate the relationship of the camera and the model being 
viewed. 
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2.6.6 Mouse Operations 
Mouse functionality has been slightly modified and enhanced.  The graphic below 
illustrates current default setting.  Changes to defaults are discouraged. 
 
 

 
Changes to note: Tentative snapping requires a simultaneous left and right mouse 

 click. 
 
Additions:  Double middle click (wheel) performs Fit View 
    

Press and hold middle is pan 

        
 
   Shift Lt is Dynamic pan 
 
 
   Roll wheel forward and back is zoom in and out 
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2.6.7 Missing buttons and Toolbars 
Right Click to customize the menu Icons displayed 
Rt click on nearly every menu allows the user to select which icons are included. 

 

Select by left clicking on items to add or remove items.  Only items with checks will be 
displayed.   
 
The standard toolbar 
 
 
Have you been looking for this toolbar?  It is off by default. 
To active it select CAD Menu -> Tools -> Standard 

2.6.8 Button Bar 
Using the Button Bar to constantly monitor or change snaps will help users to properly 
utilize CAD snaps at all times.  This is especially beneficial when used in conjunction 
with AccuSnap.   CAD Menu -> Settings Snaps -> Button Bar 

 

2.6.9 Save Settings 
Retaining changes to Menus 
Changes made to customize toolbar layouts and other Menu changes can be retained from 
one user session to the next by Saving Settings 
 
Access save setting from the CAD menu -> File -> Save Settings 
Alternately, CTRL -> F 
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2.7 Seed Files 
When you create a project in MX XM most of the seed files will be automatically set-up.  
Take a few minutes to verify they were properly set-up as follows: 
 
Make certain you have the correct seed files, which for DPW creation at INDOT using 
Imperial units are INDOT_IMP_seed.dgn which you will notice has a black 
background, and the seed to be used for the creation of DPFs is 
INDOT_IMP_vseed_ft.dgn which has a white background to represent a sheet. 
 
The metric seeds to be used are INDOT_MET_seed.dgn which you will notice has a 
black background for the DPW creation and INDOT_MET_vseed_m.dgn which has a 
white background to represent a sheet for the DPFs.  
 
A new addition to the seed file selection is Default Sheet Model seed, which are used as 
the default seed for new .dgn files for drawing pages.  The files needed are 
INDOT_IMP_sheet_seed.dgn and INDOT_MET_sheet_seed.dgn respectively. 
 
Use of any other seed files is likely to lead to unpredictable results.  
Previously selecting the .cel library file was important; however this is no longer 
relevant. 
You can check the seed file at any stage in MX in MicroStation by using: 

View -> Configuration and clicking on the File Management tab.  
 

 
 

Click OK to accept. 
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2.8 Running Input Files 
Running an Input File is virtually the same as in the 2004 version of MX.  The main 
difference is that you will be using MicroStation to modify any final drawings. 

To process an input file select File -> Input  the top left of the MX MicroStation Display. 

 

Then navigate to and select the desired input file and click on the Open button. 

 



MXRoadmax MicroStation  Running Input Files

 

 
INDOT Production – Surveys  

 2.8-28 

 

Once the input file is processed, a finish statement will be displayed in the MX Output 
Window. 

 

 

Excercise  2.8.1 : Running Topo & Corner Input Files 

1. Select File -> Input  from the MX File menu in the upper left. 

2. Navigate to the Training project folder on your computer.  It is located in the 
following location: C:\Projects\Training\Project Files. 

3. Choose the Training Topo.inp file from the list. 

4. Click on the Open button. 

5. Verify that the finish statement is displayed at the bottom of the MX Output 
Window. 

6. Select Report -> Standard Reports -> Model Names from the upper right of the 
MX display. 

7. Click the OK button at the Report:Model Names pop-up menu to display all 
model names. 

  

8. Review the list of Model Names in the MX Output Window to ensure that the 
Models Topo, and Survey Alignment were created. 

9. Repeat steps 1 thru 8 for the Training Corner.inp file.  Make sure that the Model 
Corner has been added. 
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Excercise  2.8.2 : Running Triangulation Input File 

1. Select File -> Input  from the MX File menu in the upper left. 

2. Navigate to the Training project folder on your computer.  It is located in the 
following location: C:\Projects\Training\Project Files. 

3. Choose the TRIANGLE_NEW.inp file from the list. (See Appendix D for an 
ascii print-out of the input file) 

4. Click on the Open button. 

5. Verify that the finish statement is displayed at the bottom of the MX Output 
Window. 

6. Select Report->Standard Reports>Model Names from the upper right of the MX 
display. 

7. Click the OK button at the Report:Model Names menu to display all model 
names. 

  

8. Review the list of Model Names in the MX Output Window to ensure that the 
Models EXCONT, and TOPOTRIA were added. 

 

Excercise  2.8.3 : Running Cross Section Input File 

1. Select File -> Input  from the MX File menu in the upper left. 

2. Navigate to the Training project folder on your computer.  It is located in the 
following location: C:\Projects\Training\Project Files. 

3. Choose the Sections.inp file from the list. (See Appendix E for an ascii print-out 
of the input file) 

4. Click on the Open button. 

5. When the input file is complete you can page through the Cross Sections using 
the Pages Toolbar.  Note that there is a dgn file created for each page of Cross 
Sections.  The MC02 alignment used in the exercise created 5 pages so there will 
be 5 dgn files. 
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2.9 Creating Survey Base Drawings 
Once the topo, corner, and triangulation input files have been processed, you are ready to 
create the survey base drawings.  In order to create the base drawings, an input file will 
be processed that creates the drawings automatically at the desired scales. The base 
drawings created are: 

Survey Alignment.dgn 

Survey Section Corner.dgn 

Survey Contours.dgn 

Survey Topography.dgn 

Survey Triangulation.dgn 

Survey RP Topography.dgn 

Survey RoutePlat All.dgn 

 

Excercise  2.9.1 : Running Create Survey Base Drawings Input File 

1. Select File -> Input  from the MX File menu in the upper left. 
2. Navigate to the Training project folder on your computer.  It is located in the 

following location: C:\Projects\Training\Project Files. 
3. Choose the create_survey_base_drawings.inp file from the list. (See Appendix F 

for an ascii print-out of the input file) 

4. Click on the Open button. 

5. Verify that the finish statement is displayed at the bottom of the MX Output 
Window. 

6. Use the Open Display\Drawing option from the MX File menu in the upper left 
to open each of the new files listed above and look at their contents. 

7. When you are done looking at the files open the Survey with references.dgn 
located at C:\Projects\Training\Project Files. 

 

Note: The size of the cells in the Survey Routeplat All, Survey rp topography, survey 
section corner, and survey topography dgn files will need to be scaled up using the 
annotation scale tool in MicroStation.  This will be covered in Chapter 3 of this 
manual.  This will be the case for any drawings created using a style set in MX XM. 
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2.10 Rotate Drawings 3D 
The View toolbar (located in the upper left of the view window) gives us access to rotate 
3D drawings to any one of 9 predefined Views.   
 
Isometric Views and Right Isometric View are the most useful to rotate quickly to a 3D 
orientation.  Option number1 – Rotate View allows dynamic view rotation. 

 

 
Results will be similar to below. 
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Note: Alternately access to 3D rotation can be obtained from mouse functions.  This 
involves the Alt-Middle dynamic rotation.  This is also the same as Option 1 Rotate  
View - dynamically 
Alt & Middle click 

 
 
 
The Drawing View will have a crosshair placed 
in the drawing,  This is automatically placed at 
the center of the graphical elements in the 
drawings.   
Any subsequent rotation will be about this point 
unless you dictate otherwise.  “This is rarely the 
desired location.”   
 
The rotation origin can be modified by 
tentatively snapping to the desired location (left 
right chord) or by graphically dragging the cursor 
to a new location.  When the cursor is moved 
over the crosshairs they become highlighted as 
shown. 
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Press and hold the left mouse to graphically drag to a new rotation origin.  AccuSnap is 
particularly useful in this operation.  When the left button is released, so is the cursor at 
the new location.   
Subsequent left mouse dragging will dynamically rotate the drawing (make sure you are 
no longer over the origin). 

 
 
Results of left drag with triangulation displayed as reference. 
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Note: Subsequent panning and additional Dynamic rotation will change the perspective, 
allowing us to see any portion of the project from any angle 
 
Returning to Plan View 
In CAD the normal Plan View as we are accustomed to describing it, is referred to as Top 
View. 
Simply select the icon to the right of Fit view. 
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Resulting view 
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2.11 Shading Triangulation Surfaces 
In order to fill in triangulation surfaces we will simply select Display Mode Smooth.  
This will give us the same functionality as MX in Windows.  Additional Rendering 
functions (such as material assignments) are available. Material assignments provides for 
displaying grass as grass, etc. 
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To return to Non Shade views we will select Display Mode WireFrame 
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2.12 Ending your MX Session 
When finished working with MX, it’s recommended that you first close your project by 
selecting File -> Close Project, followed up by exiting MXROADMAX MicroStation by 
selecting File -> Exit.  If you choose to exit by selecting File -> Exit without first closing 
the project you may encounter a Bentley Software error report.  Cancel out of the error 
report and any other messages that follow. 
 

2.13 Closing MX manually 
If MX stops functioning, you will need to stop the session manually.  You may do this 
via the following steps.  When MX freezes up, the first thing to do is bring up the 
Window task manager by clicking the right mouse button on the Windows Taskbar and 
selecting Task Manager with a left mouse click. 
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The first item to stop will be the MX option highlighted in the Applications Tab.  To do 
this, left click on the MX option to select it, then left click on the End Task button. 
 

 

The second item to be stopped is the Mosseng.exe on the processes tab; this will halt the 
MX engine and stop any additional MX functions that do not stop properly.  Select the 
moss application by left clicking on it, then left click on the End Process button. 
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Chapter 3 -Route Plat Sheet Creation 
Now that the survey base drawings are complete you will need to create the Route Plat. 
For the route plat creation in this class we will use MicroStation XM. Note that the Route 
Plat creation steps in this section may be in a different order than you are accustomed too.  
If you prefer to change the order on projects in your office that’s fine but please follow 
the steps outlined herein for the training session as it will make things easier for 
everyone. 

The easiest way to open a dgn file in MicroStation XM is using the 
MicroStation V8 XM Edition icon on your desktop.  Double left click on 
the icon and then navigate to the desired dgn file location to select and open 
the file. 

 

Note: 

Another easy way to open the dgn file is to have the Windows Explorer open and 
navigate to the folder containing the dgn file you want to open.  Then left click on the 
filename and drag it onto the MicroStation V8 XM Edition icon on your desktop.  This 
will automatically open the selected file in a MicroStation session. 

 

Note:  

If you double left click on the dgn file in the Windows Explorer to open it the default will 
be to open the file using MicroStation Powerdraft v8 XM.  This is a slightly toned down 
version of MicroStation v8 XM with the only notable difference being advanced 3D 
rendering.  However it will not open with the same customized toolbar settings as 
MicroStation v8 XM. 

 

3.1 The Route Plat MicroStation File 
The template route plat dgn file, routeplat_eng.dgn or routeplat_met.dgn, is stored in the 
Project Files directory of your project folder. 

Open the dgn file by first double left clicking on the MicroStation V8 XM Edition icon on 
your desktop.  When the ProjectWise Log in prompt appears, left click on Cancel. 
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Navigate to the location of your routeplat_eng.dgn file. (C:\projects\Trainings\Project 
Files\routeplat_eng.dgn)  Left click on the file name to select it and then left click on 
Open. 

 

 

3.2 What’s New in MicroStation XM 
Once you open the dgn file, you will notice the MicroStation XM display looks very 
similar to that of MicroStation v8 2004.  There are some differences in the functionality, 
and this section goes through those that apply to the survey workspace. 
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3.2.1 Tasks  
The most obvious change within MicroStation is the location of the INDOT tools which 
have been migrated from the INDOT pull down to the Task Navigation tool box which is 
new to MicroStation V8 XM. 

 

 
 

 
All of the options above the “Drawing” option are 
INDOT’s customized tools. The following are two Tasks 
that will be useful to the survey workspace, and their 
associated functions. 

 Professional Stamps 
• Professional Stamps 

 Survey 
• Place Line 
• Survey Cells 
• Place Text 
• Place Note 

 
 

The Task Navigator can be set-up as a tool box or a dialog.  To change between the 
modes select Workspace->Preferences->Task Navigation and set the Presentation to 
either Tool Box or Dialog. 
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If you choose the tool box mode, the Task Navigator will be located on the right edge of 
the display. 

 

If you choose the dialog mode, the Task Navigator will be located on the left edge of the 
display.  The dialog gives a description of the task in addition to the icon. 
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3.2.2 Design History  
A new icon in the right portion of the status bar indicates if a file has design history.  
Design history allows the user to commit their changes and add comments as to the 
changes made to the drawing file.  It also is a log of who has opened the file.  The 
template survey route plat dgn file will have design history initialized.  If there are 
uncommitted changes, a pencil is superimposed on the icon’s scroll. 

       

MicroStation automatically stores any changes to the dgn file, but design history allows 
the user to revert back to a previously committed state of the drawing.  For this reason it 
is recommended that the user periodically commit their changes to design history, at a 
minimum the end of each day is recommended.  The following steps go through the 
procedure. 
 

1. Left click on the design history scroll and pencil. 

 

 

2. Left click on Commit. 
 
3. Type a comment into the Commit Changes Dialog box.  The comment should 

describe the changes you made to the dgn.  
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4. Left click on OK.  Your changes and comment will be added to the design 
history. 

 
5. To view the design history of a file, Left click on the scroll. 

 
6. Left click on Design History 

 

7. The Design History dialog box will appear.  It contains a listing of all the 
committed changes. 

 

Note:  
Each time you exit MicroStation it commits the changes to design history but there 
are no comments.  Without the comments it would be difficult to revert back to the 
desired modified point.  
 

 
The following steps go through the procedure of reverting back to a previous 
modification point of the drawing. 
 

1.  Left click on the scroll. 
 

2. Left click on Design History. 
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3. Left Click on one of the committed changes to select it.  In the drawing display, 
the changes are highlighted.  Items that were added are green, those deleted are 
red, and items that were modified are blue.  

 

4. If you would like to undo the changes made by that commitment, Left click on 
the Undo selected historic changes tab.  

 

 

Note: 
In order to make the Undo selected historic changes tab active you will need to 
left click on the Show elements that were modified tab first. 

 
5. If for some reason you need the changes back you can Left Click on the 

committed change to select it, then Left click on the Redo selected historic 
changes tab. 

 

 

Note: 
In order to make the Redo selected historic changes tab active you will need to 
left click on the Show elements that were modified tab first. 
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3.2.3 INDOT – INFO 
Although the INDOT pull-down menu has been replaced by task based tools, there are 
three information based menu items that are of interest to users of the INDOT 
Workspace.  Those three items are located in an INDOT – INFO menu option that is 
located under the MicroStation Help Menu pull-down. 

 

Submit Problem Report: Opens an Internet Explorer 
window with the CAD Support Help Site active. 

FAQ Page: Opens an Internet Explorer Window with 
the FAQ section of the CAD Support Help Site 
active. 

Map Insert Page: Opens an Internet Explorer 
Window with the GIS MicroStation Map Insert page 
active. 

 
 

3.2.4 MicroStation Models 
A Model gives you the ability to store multiple independent sets of design data within the 
same file (INDOT detail).  Before V8, all geometry placed in the design file occupied 
essentially the same design cube, which is why the user had to clip what they referenced 
in.   
 
A DGN file is composed of models. When you draw or place elements with MicroStation 
tools, the elements are added to the active model. A model can be either 2D or 3D, and is 
stored as a discrete object within the DGN file. There are two categories of models:  
design or sheet. Two subcategories exist for each allowing for “from seed” options as 
explained below. The user then has the option of creating 4 different types of models. 

Model Types 
The following definitions and information is paraphrased from Bentley course 
documentation on models for clarity. 
   
Design models 
Design Models consist of design geometry, usually at full scale and in the working units 
associated with the project.  Design models and can be either 2D or 3D. A design model 
can also be used as a reference or placed as a cell. In MicroStation, you can create an 
unlimited number of design models in a DGN file.  
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For example: one Model could hold the plan view of a Bridge deck and a second model 
could hold the section view of a Bridge deck.  This allows each of these views to be 
referenced in at a different scale on the sheet model. 

Design from Seed gives you the option to select a seed file that has different model 
properties than in the current MicroStation drawing.  In all other respects, it is the same 
as a normal design model.  An example of this would be different working units.  These 
models cannot be placed as cells. 

 

Sheet models 
The Sheet Model is more closely associated with creating traditional paper drawings.  
Instead of redrawing the model’s geometry for each view, you attach views of the design 
geometry for each view.  These views of the design geometry are attached as references.  
They can also be placed as a cell if desired.  Sheet Models are most commonly used for 
composing finished and annotated drawings. MicroStation allows you to create an 
unlimited number of sheet models per DGN file.  You may rotate sheet model views, but 
only about the Z axis. Sheet views are planar to the view.  This mimics the 2D nature of 
printed output. 

The Sheet from Seed type model is created from a selected seed file.  This model uses the 
seed model’s attributes, and it includes any references attached to the seed model.  The 
option to place a model as a cell is not available. 

 

When you first create a DGN file, it has a default design model ready to place elements. 
When you open the Models dialog box, the default model has the name Default, with the 
Description as Master Model. You can use this model and, if necessary, change its name 
and description as desired. 

Models can be self-referenced into the sheet without having to clip the elements.  They 
can be selected in the Attach Reference Settings box and a scale can be applied as well.  
Models can be imported into other drawings too, which means that the detail only has to 
be created one time and scaled as needed. 

 

3.2.5 Annotation Scale 
 
In XM MicroStation, cell sizes can be changed globally within a drawing. The tool that 
allows this to be accomplished is called Annotation Scale.  In the INDOT XM 
workspace, the MX style sets are designed to utilize the annotation scale function.  For 
this reason the first time you open a drawing created using a style set the drawing scale 
will have to be set-up.  The following steps go through the initialization. 
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1. To open the Drawing Scale tool box select Settings -> Drawing Scale from the 
MicroStation menu. 

 

 

2. The Drawing Scale tool box will contain the default settings for the drawing file.  
Verify that the unit settings are correct for the job you are working on, either 
English (feet, inches), or Metric (meters, and millimeters).  As long as the proper 
seed files have been verified the units should be correct as well.  With the default 
Drawing Scale settings many of the cells will appear as dots such as in the 
example below. 
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3. Left click on the Annotation Scale button to enable it. 

 

 

4. Left click on the Scale pull down and scroll to the desired scale and left click on 
it to choose it. 
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5. When the Alert box pops up left click on Yes to propagate the annotation scale. 
 
6. Once the drawing updates, the Drawing Scale settings will be updated and the 

cells and linestyle scales will also be updated in the drawing as in the example 
below. 

 

 

 

7. Be sure to Save Settings with a Ctrl + F, or File -> Save Settings. 
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Excercise  3.2.1 : Set the Annotation Scale on the Base Drawings 

1. Open the MicroStation file survey alignment..dgn located at  
C:\Projects\Training\Project Files\ 

 
2. Enable Annotation Scaling, and set the scale to either MX base 1”=200’, or 

1”=200’ which ever is available. 
 
3. Be sure to save settings on the file before exiting with Ctrl+F or File->Save 

Settings. 
 

4. Repeat the procedure and set the scale to either MX base 1”=200’, or 1”=200’ 
for the following drawings located at C:\Projects\Training\Project Files\ 

- survey routeplat all.dgn 

- survey rp topography.dgn 

- survey section corner.dgn 

- survey topography.dgn 

 

3.3 Contents of the Template Route Plat dgn File 
The template route plat dgn file contains four MicroStation models.  Open the models 
dialog box by left clicking on the Models icon from the primary toolbar, or by choosing    
File -> Models. 
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This will open the Models dialog box which displays the five default route plat models. 

 

The four default models and their contents are as follows: 

Coordinate Table:  This is the template Reference Point Coordinate Table model 

Default:  This is the default MicroStation model 

Plat:        This is the template route plat sheet model 

Point Number:   This is the template reference box model 

SV_Section Corner Reference Card Sheet:  This is the template Section Corner 

                                                                           Reference Card Model 

 

 

3.4 Creating Reference Boxes 
 

The following steps go through the process of creating a model containing the control 
point reference box for use in either the Route Plat Sheet or the Section Reference Card. 

 
1. Open the MicroStation Route Plat File. (routeplat_eng.dgn) 
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2. Click on the Models dialog box icon to open it. 

 

 
3. Double left Click on the Model named Point Number to open it.  Once selected 

the model name will be highlighted green. 
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4. Select the Copy a Model tab at the top of the Models dialog box. 

    

  
5. Change the name to the desired Point Number. (174) 

 
6. Change the description to desired Point Description. (EAST CORNER 

S.35,T.21N.,R.9E.) 

                          

 
7. Select OK and a new Model called “174” will be created. 
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8. If not automatically opened, open the “174” Model by double clicking on it in the 

Models Dialog box. 

        

 
9. Zoom to the extents by either double clicking the mouse wheel or using the 

zoom controls in the upper left corner of the display. 

 

10. Look at the newly created reference box, taking note of the automatically 
annotated point number and description.  

 
Note: Text Fields have been utilized to automatically fill in the text for these labels.  If 
you double left click on the text, ‘174’ for example,  it will bring up the text editor.  
Then you can right click on the text in the text editor which will give more options, left 
click on Edit Field to open the Fields Editor. 
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In the Fields Editor you can choose any of the listed fields; name, type, description, 
etc.
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11. Now lets create the line work, text, etc. for control point 174 as shown below. 

 

12. First make sure your task navigator is set to dialog and the Survey Taskbar is 
selected. 
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13. Add the north arrow cell by selecting the Survey Cells tab in the Task Navigator, 
or press Escape and then W. 

 

then once the Cell Library dialog box appears scroll down to the North Arrow 
cell, NARROW, and double click on it. 

 

In the Place Active Cell dialog box the default scale is 1.000 which is appropriate 
for the reference box size.  Place the cell by moving the mouse pointer to the 
appropriate location and then clicking the left mouse button. 

 

Note: 
You can use the mouse wheel to zoom in and out. Pressing the mouse wheel and 
moving the mouse pointer will allow you to pan your view.  You can also use the 
zoom controls in the upper left corner of the display. 
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14. Repeat step thirteen, and insert the traverse station cell (PSSA) and the power 
pole cells (PPWP).  When your done with these cells close the Cell Library 
dialog box by clicking on the X in the upper right corner of the dialog box. 

 
15. Next place the line representing the road centerline. Start by selecting the Place 

Line tab on the Task Navigator, or press Escape and then Q. 

 

Then left click in the starting and ending locations to draw the line. Since the 
default line style is a solid line, lets change it to a centerline line style.  Click on 
the element selection tab, or hit Escape and then 1 

  

Right click on the line and hold the right mouse button down while selecting the 
Properties tab, then double left click on line in the upper portion of the Element 
Info dialog box. 
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With the line Information displayed, left click in the right portion of the Line 
Style row.  Left click on the selection tab and browse to the centerline style (4) 
and choose it. 

 

The Information box will update to show the new linestyle. 

 

Close the Element Info box and left click in the display to deselect the line.  The 
line should appear with a centerline linestyle. 

 

Note that if you have trouble clearing out the element selection you can use the 
clear selection button on the element selection dialog box. 
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16. Now lets move the PSSA cell so it is centered on the newly drawn centerline.  
Start by using the element selection tool to select the PSSA.  Then press the right 
mouse button and select Move.  Change the snap mode to center circle and click 
the right and left mouse buttons simultaneously near the circle portion of the 
PSSA.  This will select the move point to be the center of the PSSA. Left click 
with the tentative snap to the center and move the PSSA towards the centerline.  
The Accudraw feature with automatically choose the midpoint of the line which 
is appropriate.  When the pointer is near that location press the left mouse button 
and the PSSA will be moved.  Left click again to deselect the PSSA. 

 
17. Next draw the lines for the dimension ties and the house/porch outline. Then 

move the PPWP cells to the correct locations. 
 

Note that you can use the accudraw tool at the bottom center of the display to 
help draw the lines at a particular angle.  Press the space bar till the display 
changes to polar coordinate system, distance and angle, as it is rectangular 
coordinate system as default, x and y. 

 

Select the line start point and move towards the ending point.  Press tab to get to 
the angle prompt, then you can type in the desired angle and hit enter, move the 
pointer along the bearing to the appropriate distance and left click to end the line. 
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Once the lines are drawn, you may need to move the cells for the features to the 
appropriate location.  At this point your reference box should look similar to the 
one below. 

 

18. Add the text labels to the Reference Box.  Start by selecting the Place Text tab 
from the Task Navigator, or hit Escape then E. 

 

Expand the Place Text dialog box by clicking on the arrow. 

 



Route Plat Sheet Creation  Creating Reference Boxes

 

 
INDOT Production – Surveys  

 3.4-25 

 

 

Make sure that the settings are appropriate, typically the defaults should be 
correct.  Change the Font to 1 WORKING if not already, this is a stick font and 
plots better when reduced. 

 

Type one of the text labels in the Word Processor. 

 

Once you have typed the text, move the mouse pointer to the desired location and 
press the left mouse button.  Then click the right mouse button and type in the 
next text label, and insert it as above.  Repeat until the labels are all completed, 
except the description of the monument type. 
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Note: For the road name and dimension labels you can change the method in the 
Place Text dialog box to Above Element.  Then you can type the text in the Word 
Processor and left click on the desired line to place the text above it, finally move 
the text to straddle the line. 

 

 

Note: If you are using font 1 WORKING, the degree symbol can be typed by 
holding down the ALT key and then pressing 9 then 4 on the number pad. 

 

Note: You can store symbol characters as favorites, which will make them easier 
to find, as follows: 

1. Left click on the Insert Symbol tab in the Text Editor dialog box.. 
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2. Find the desired symbol in the list and right click.  Then left click on Add to  

    Favorite List. 

.  

3. At the Add character to favorite list type in a name for the symbol and then  

    left click on Add. 

 

 

4. Close the Symbols dialog box. 

5. Next time you need the symbol in the Text Editor left click on the Arrow next to 

    the Insert Symbol tab and then left click on the name of the symbol. 
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At this point your reference box should look similar to the one below. 

 

19. The final step is to add the description for the monument type.  Start by selecting 
the Place Note tab from the Task Navigator, or hit Escape then R. 

 

Expand the Place Note dialog box and make sure the settings are correct.  Check 
to see that the Text Frame is a Box.  

 

Type the text for the note in the Word Processor, and make sure the font is           
1 WORKING, this is a stick font and plots better when reduced. 
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Once you have typed the text, move the mouse pointer to the desired location for 
the start of the leader and press the left mouse button, move to the angle location 
and click the left mouse button again, then right click to end the insertion.  When 
you are done close the Word Processor dialog box. 
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At this point you are finished creating the reference box for point 174 and it 
should look similar to the one below. 

 

20. You will need to create a reference box model for each control point that will be 
shown in a reference box.  Then add the graphics to complete the reference box 
for each point. 

 

3.5 Creating Reference Point Coordinate Table 
Since the coordinates for the Reference Points are no longer contained in the Reference 
Box a Coordinate Table you will need to create a coordinate table.  It is recommended to 
create one overall coordinate table for the Route Plat. The following steps go through the 
process of creating a Coordinate Table. 

 
1. Open the MicroStation Route Plat File. (routeplat_eng.dgn) 
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2. Click on the Models dialog box to open it. 

 

3. Click on the route coordinate table model (Coordinate Table) to select it. 
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4. Select the Copy a Model tab at the top of the Models Dialog Box.  

 

5. Change the name to the desired Plat name. (Overall Coordinate Table) 
 

6. Change the description to the desired. (Reference Point Coordinate Table) 

 

7. Select OK and a new Model will be created. 
 
8. If not automatically opened, open the Overall Coordinate Table model by double 

clicking on it in the Models dialog box. 
 

9. Select the text to edit it by double left clicking on it.  Then use the Text Editor to 
modify the text as necessary. 
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Excercise  3.5.1 : Create a new Coordinate Table and Add Point 174 

5. Open the MicroStation file routeplat_eng.dgn located at  
C:\Projects\Training Project Sample Route Plat\Project Files\ 

 
6. Follow steps 2 through 8 from the previous section, Creating Reference Point 

Coordinate Tables, to create a new coordinate table. 
 
7. Edit the text for the first point in the coordinate table to contain the information 

for Point 174. 
Point Name:  174 

Northing: 13,221.0790 

Easting: 85,296.1035 

Line:  N.A. 

 

 

3.6 Creating Route Plat Sheets 
Each sheet of your Route Plat will need a model.  The following steps go through the 
process of creating additional Route Plat sheets. 

 
 

1. Open the MicroStation Route Plat File. (routeplat_eng.dgn) 
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2. Click on the Models dialog box to open it. 

 

3. Click on the route plat model (Plat) to select it. 
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4. Select the Copy a Model tab at the top of the Models Dialog Box.  

 

5. Change the name to the desired Plat name. (Plat Sheet 1) 
 

6. Change the description to the desired. (Routeplat Sheet 1) 

 

7. Select OK and a new Model will be created. 
 
8. If not automatically opened, open the Plat Sheet 1 Model by double clicking on it 

in the Models dialog box. 
 

9. Repeat the copy process for each plat sheet necessary. 



Route Plat Sheet Creation  Adding DGN Files to the Route Plat

 

 
INDOT Production – Surveys  

 3.7-36 

 

 
10. When complete, you should have a model for each Route Plat Sheet. 

 

 

3.7 Adding DGN Files to the Route Plat 
The following steps go through the process of adding the topography and other necessary 
dgn files as references to the Route Plat Sheet. 

1. Open the MicroStation Route Plat File. (routeplat_eng.dgn) 
 
2. Click on the Models dialog box to open it. 

 

3. Double Click on the desired route plat model (Plat Sheet 1) to open it. 
 
4. Using the zoom tools, or by double clicking the mouse wheel, zoom extents.  The 

template Plat Sheet contains the Route Plat Basesheet and a grid that is gray 
scale. 



Route Plat Sheet Creation  Adding DGN Files to the Route Plat

 

 
INDOT Production – Surveys  

 3.7-37 

 

5. Select the References tool box. 

     

6. Click on Attach Reference.  
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7. Select the files you would like to reference into the route plat sheet. You can hold 
down the Ctrl key and select multiple files. Then click Open. 
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8. In the Reference Attachment Setting dialog box verify that the file name is 
correct, then type in a Logical Name for the file being attached, select 
Coincident under the View, and change the scale to the desired sheet scale (200 
scale is shown below).  Because the drawings are now 1:1 scale, you need to 
multiple the desired scale be 12 to get the appropriate scale for the reference file.  
Click OK and the reference will be added to the drawing in the location of its 
coordinate system.  If you selected multiple files to attach, the dialog box will 
reappear for the next file.  Repeat until all files are attached. 

 

9. Most likely the attached reference files will not be located on the basesheet where 
you want them.  You will have to move them.  Start by zooming extents, then in 
the References dialog box, choose all the attached reference filenames you want 
to move, and select the Move References tab. 
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Left click at the location in the drawing you want to move the files from and then 
left click at the location in the drawing you want to move the files to.  This will 
move all the selected files to the new location. 

10. Be sure to save settings by hitting Ctrl and F, or selecting File -> Save Settings.  
This well ensure that the changes you made to the reference files will be saved 
for next time. 

11. If you want to clip the reference the easiest way is to use a fence.  Select the 
Fence tool, or Escape then 2 then 1. 

 

Left Click at the desired four corners of the area to be clipped.  Once the fence is 
placed, select the files to be clipped in the Reference dialog box, and select Clip 
Reference. 

 

In the Set Reference Clip Boundary dialog box make sure the method is Active 
Fence and left click in the display. 

 

Note: You could draw a polygon and change its Class to Construction.  Then by 
changing the Fence Type to Element you can create the fence by selecting the 
polygon.  This would give you a way of recreating the same clip area for 
additionally attached reference files.  
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12. Be sure to save settings by hitting Ctrl and F, or selecting File -> Save Settings.  
This well ensure that the changes you made to the reference files will be saved 
for next time. 

 

3.8 Adding Ref. Boxes to Route Plat 
The following steps go through the process of adding the control point reference box 
models to the Route Plat Sheet. 

 
1. Open the MicroStation Route Plat File. (routeplat_eng.dgn) 
 
2. Click on the Models dialog box to open it. 
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3. Double Click on the plat model (Plat Sheet 1) to open it. 

 

4. Using the zoom tools, or by double clicking the mouse wheel, zoom extents.  The 
template Plat Sheet contains the Route Plat Basesheet and a grid that is gray 
scale. 
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5. Select the References dialog box. 

 

 
6. If not already opened, click on the Models dialog box to open it. 

 

 
7. In the Models dialog box, select the models you want to add to the Route Plat by 

left clicking on them. (174) 
 
8. Hold down the left mouse button and drag and drop the selected model names 

into the References dialog box. 
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9. When the Attach Source Files dialog box appears, change the Attachment 
Method to Top, and click Ok. 

 

 
10. Using the mouse pointer, navigate to the desired insertion point and click the left 

mouse button.  The gray grid was created to give a symmetric placement of the 
boxes. 

 

 

11. Repeat the placement process for each control point reference box you want to 
add to the Route Plat Sheet. 

 
12. When complete, you should have a reference file attached for each control point 

reference box. 
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13. In order to turn off the grey grid/insertion lines, select the View Attributes 

toolbox in the upper left corner of the view frame, and uncheck the constructions 
checkbox. Then hit Ctrl+F to save settings for future use. 
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3.9 Adding a Coordinate Table to the Route Plat 
The following steps go through the process of adding a Coordinate Table to the Route 
Plat Sheet. 

 
1. Open the MicroStation Route Plat File. (routeplat_eng.dgn) 
 
2. Click on the Models dialog box to open it. 
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3. Double Click on the plat model (Plat Sheet 1) to open it. 

 

4. Using the zoom tools, or by double clicking the mouse wheel, zoom extents.  The 
template Plat Sheet contains the Route Plat Basesheet and a grid that is gray 
scale. 

 



Route Plat Sheet Creation  Adding a Coordinate Table to the Route Plat

 

 
INDOT Production – Surveys  

 3.9-48 

 

 

5. Select the References dialog box. 

 

 
6. If not already opened, click on the Models dialog box to open it. 

 

 
7. In the Models dialog box, select the Overall Coordinate Table model by left 

clicking on it. 
 
8. Hold down the left mouse button and drag and drop the selected model name into 

the References dialog box. 
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9. When the Attach Source Files dialog box appears, change the Attachment 
Method to Coincident, and click Ok. 

 

 
10. The Overall Coordinate Table will be added to your Route Plat Sheet.  You can 

change its location by selecting the Move References icon and then left clicking 
on the location you want to move it from and finally left clicking on the location 
you want to move it to.  
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3.10 Creating Section Corner Cards 
The following steps go through the process of creating a new Section Corner Card and 
adding the reference box to the Section Corner Card. 

 
1. Open the MicroStation Route Plat File. (routeplat_eng.dgn) 

 
 

2. Left Click on the Models dialog box to open it. 

 

3. Left Click on the section corner card model (SV_Section Corner Reference Card 
Sheet) to select it. 

 
 
 

4. Select Copy a Model tab at the top of the Models Dialog Box. 
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5. Change the name to the desired monument name. (EAST CORNER S.35 T.21N. 
R.9E.) 

 
 Note that comma’s are not permitted.  

 
6. Change the description to desired. (174) 

 

7. Select OK and a new Model will be created. 

 

8. If not automatically opened, open the “EAST CORNER S.35 T.21N. R.9E.” 
Model by double clicking on it in the Models dialog box. 

 
9. Now lets add the reference box, select the references toolbox. 
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10. In the References dialog box double Click on  routeplat_eng.dgn file to select it. 

 

11. In the Attachment Settings dialog box, select the Model pull down menu and 
choose the desired reference box model.(174). 

 

12. Click Ok. 
 

13. The Reference Box for Point 174 will be automatically inserted into the Section 
Corner Card. 
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14. Be sure to save settings by hitting Ctrl and F, or selecting File -> Save Settings.  
This well ensure that the changes you made to the reference files will be saved 
for next time. 

 
15. You will need to fill-in the rest of the Section Card information. 

 
16. Repeat the procedure for each section corner card necessary. 

 
17. When complete, you should have a section card model for each section card. 

 

Excercise  3.10.1 : Open Completed Route Plat and Check it out 

1. Open the MicroStation file routeplat_eng.dgn located at  
C:\Projects\Training Project Sample Route Plat\Project Files\ 

 
2. Open the Models dialog box and note the existing models for each reference box 

and plat sheet. 
 

3. Open the Model entitled Plat Sheet 2. 
 

4. Zoom around the Route Plat to view what the finished product would look like. 
 

5. Open the Model entitled Plat Sheet 3. 
 

6. Zoom around the Route Plat to view what the finished product would look like. 
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Chapter 4 -Plotting 
Plotting in the XM workspace for surveys will be accomplished using Print/Plot in 
MicroStation, in the same manner as the 2004 v8 workspace.  All of the plotting 
configuration and settings files reside on the “X” drive for those using a computer on the 
network and on the “C” drive for those not connected to the network.. 

 

4.1 Plotting in MicroStation XM Using Print/Plot 
 

1. Open the MicroStation file containing the sheet you would like to plot. 
(routeplat_eng.dgn) 

 
2. Select File->Print, or type Ctrl+P to open the Print/Plot dialog box. 
 
3. Left click on the Configure Windows Printer button and select the desired 

plotter. 
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Scroll through the available printers and plotters to find the desired plotter.  Once you 
have selected it, select Print.  This will return you to the Print/Plot dialog box, it will not 
send a plot. 

 

4. Next select the arrow to the right of the Paper Size scroll and choose the 
appropriate paper size. 
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5. If the plot area is not covering the entire preview display uncheck the Full 
checkbox and then re-check it. 

 
6. Change the color to Grayscale, unless you want a color plot. 

 

7. Verify that the Print Scale and Size seem to be reasonable. 
 
8. Select File->Print, or click on the printer icon on the dialog box to send the 

plot/print. 
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4.2 Plotting to a PDF file in MicroStation XM Using Print/Plot 
 

1. Open the MicroStation file containing the sheet you would like to plot. 
(routeplat_eng.dgn) 

 
2. Select File->Print, or type Ctrl+P to open the Print/Plot dialog box. 
 
3. Left click on the Select Printer Driver Configuration File button and select the 

desired configuration file, 
X:\WRKSPC_INDOT_XM\Workspace\Standards\plotdrv\pdf.pltcfg or 
C:\WRKSPC_INDOT_XM\Workspace\Standards\plotdrv\pdf.pltcfg 
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4. Check to make sure the paper size is Arch D, the scale is 0.0833, and the color is 
set to Grayscale unless you want a color plot. 

 

5. Select File->Print, or click on the printer icon on the dialog box to send the 
plot/print. 
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6. Navigate to the desired storage location and input the appropriate filename for 

the pdf.  Then left click on the Save button. 

 

7. Double left click on the pdf filename in Windows Explorer to open it in Adobe 
Acrobat.  Then select File->Print option to plot the sheet.  Choose an appropriate 
Printer/Plotter and left click on Ok to print the sheet. 
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4.3 Plotting Configuration 

4.3.1 Printer/Plotter locations: 
 

Printer/Plotter Model Location Print Server Name/Description
Oce TDS 400 (B/W) 6th Fl. Center (N. of main aisle) INDOTGE8 6C OceTDS400 
Oce TDS 400 (B/W) 6th Fl. Center (N. of main aisle) INDOTGE8 6E OceTDS400 
HP 5000 (Color) 6th Fl. Center (N. of main aisle) INDOTGE8 6E 5000ps 
HP 5000 (Color) 6th Fl. West (SW corner) INDOTGE8 6W 5000ps 
HP 5000 (Color) 9th  Fl. West End INDOTGE8 9W 5000ps 
Oce TDS 600 (B/W) Laporte District INDOTGE8 LA OceTDS600 
Oce TDS 600 (B/W) Ft. Wayne District INDOTGE8 FW OceTDS600 
Oce TDS 600 (B/W) Crawfordsville District INDOTGE8 CR OceTDS600 
Oce TDS 600 (B/W) Greenfield District INDOTGE8 GR OceTDS600 
Oce TDS 600 (B/W) Seymour District INDOTGE8 SY OceTDS600 
Oce TDS 600 (B/W) Vincennes District INDOTGE8 VN OceTDS600 
Oce TDS 600 (B/W) Materials & Test INDOTGE8 MT OceTDS600 

 
Note:  Any printers not listed in the preceding table can be added from 

<Floor no.>PRTSRV   Example: 6PRTSRV (6th Floor) 

This list does not include any printers that may have been added per request.  Please 
contact your CAD Team representative or the CAD Support Staff via a Help Desk Ticket 
and we will assist you in locating what printers have been setup for your sections. 
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4.4 Adding Printers and Plotters 
 
Open Windows Explorer and type \\INDOTGE8 or \\<Floor no.>PRTSRV in the address 
bar.  A list of available printers and plotters will be displayed.  Double click on the 
printer or plotter desired and it will then be available for use. 
 
Note:  Printers and plotters can still be added by the Add Printer Wizard, more details can 
be found on the CAD/GIS FAQ page. 

4.4.1 Print/Plot Drivers 
 

/Plot Driver 

printer.tbl 2D and 3D Full Size Sheets 

printerc. tbl 

printer_8x11. tbl 

2D and 3D Full Size Sheets in Color 

2D and 3D 8 x 11 Size Sheets 

printer_11x17. tbl 2D and 3D 11 x 17 Size Sheets 

printerc_11x17. tbl 

printer-survey4x6. tbl 

dcgen.tbl 

2D and 3D 11 x 17 Size Sheets in Color 

4 x 6 Survey Field Book Information 

2D and 3D Full Size Sheets with an Image 

dcgen_color.tbl 2D and 3D Full Size Sheets with an Image in Color 

dcgen_mono.tbl 2D and 3D Full Size Sheets with an Image in B/W (Linestyles 0,1 
slightly thicker) 

dcgen_color_11x17.tbl 2D and 3D 11 x 17 Size Sheets with an Image in Color 

dcgen_mono_11x17.tbl 

colour-fill-oce.tbl 

pdf.tbl 

2D and 3D 11 x 17 Size Sheets with an Image in B/W 

2D and 3D Sheets with an Image for Public Hearings 

2D and 3D Sheets for PDF format 

 

These files are located at: X:\WRKSPC_INDOT_XM\Workspace\Standards\plotdrv. 

Be sure to only use these drivers and not the ones located on your C:| drive. 
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Chapter 5 -ProjectWise and the Survey Workspace 

5.1 Creating a New Survey Project 
As of the release of the 2008 version of the INDOT Workspace, ProjectWise will be the 
tool used to manage a project throughout its lifecycle. This chapter goes through the 
process of creating a new project and then adding it to the ProjectWise database once the 
project is completed. 

 
The procedure for creating a new Survey Project will be completed outside of 
ProjectWise, and involve the use of existing template projects.  These template projects 
are located in the C:\Projects\Templates directory on your computer.  The following 
steps go through the process of creating a new project. 

1. Using the Windows Explorer navigate to the directory: C:\Projects\Templates 

 

Note: There are two template project folder structures.  The first is for those projects 
using English Units (Surveying – Project English).  The second is for those projects using 
Metric Units (Surveying – Project Metric). 
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2. Right Click on the desired project type and select Copy. 

 

 
3. Navigate to the directory: C:\Projects 
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4. Right Click on the folder titled Projects and select Paste. 

 

5. Right Click on the newly created folder (Surveying – Project English) and select 
Rename. 
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6. Change the name of the folder to your desired project name (9999999_SR01) 

 

7. Once you rename the folder, your new project is created.  Shown below is the 
Surveying – Project English folder and its contents.  The metric template project has 
the same structure, except it contains metric seed files for the template dgn files. 

 
 
Note that the template dgn files including those for the 
Route Plat are stored in the Project Files folder. 
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5.2 Adding a Completed Project to ProjectWise 
The following section goes through the procedure for adding a completed Survey Project 
to the ProjectWise datasource. 

5.2.1 Starting ProjectWise 
The following are the two most typical ways to start the ProjectWise software. 

The first way is to double click on the ProjectWise Explorer icon on your 
desktop.  This will take you to the main screen of the ProjectWise 
Explorer. 

 
 
 
 
 
 
 
The second way is through the 
Windows Start Menu.  Click 
on Start, select All Programs, 
select Bentley, select 
ProjectWise V8 XM, and click 
on ProjectWise Explorer.  This 
will take you to the main 
screen of the ProjectWise 
Explorer. 
 
 
   
 

 

 

 



ProjectWise and the Survey 
Workspace  Adding a Completed Project to ProjectWise

 

 
INDOT Production – Surveys  

 5.2-6 

 

After the ProjectWise Explorer has been started you will see the main screen. 

 

 

5.2.2 Accessing the INDOT Datasource 
Once you are at the main screen of the ProjectWise Explorer, you will need to login to  
INDOT ProjectWise. 

 

As long as you are logged onto the computer with your INDOT credentials all you need 
to do is double click on the icon titled INDOT ProjectWise.  This will expand the 
Database Tree so you can access your project files. 
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If you are not logged onto the computer with your INDOT credentials or someone else is 
logged onto the computer, you will need to right click on the icon titled INDOT 
ProjectWise.  Then select the Log in as option.  The log in menu will pop-up.  Fill in the 
necessary information; making sure the datasource is as below, type ‘dot\’ before your 
user name, and enter your INDOT login password. 

 

 

 

After successfully logging in you will have access to the data stored in INDOT 
ProjectWise. 

 
 
Click on the plus symbol next to the appropriate folder to expand it.  In this manner you 
can navigate to the desired project folder or data file. 
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5.2.3 INDOT Folder Structure 
All projects reside under Documents in the data source tree within the ProjectWise 
Explorer.  Each section that utilizes the CAD workspace will have a separate folder in 
this area. 

 

Survey projects completed by aerial engineering will reside under the folder labeled 
Central Offices > Aerial Engineering > Surveying or Photogrammetry.  

 

 

 
Survey projects completed by District Offices will reside under the folder labeled District 
Offices > (Name of District) > Surveying.  
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Central Office – Aerial Engineering Folder Structure 
 
Aerial Engineering 
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District Offices - Surveying Folder Structure 
 
Surveying 

                     

 

5.2.4 Importing the Project into ProjectWise 
In order to import the completed project into ProjectWise you will drag and drop the 
folder from your local drive into the ProjectWise datasource.  The following steps will 
take you through the process 

1. On your desktop, split the display with Windows Explorer on one half and the 
ProjectWise Explorer on the other as shown below. 

    

2. In the Windows Explorer navigate to the location of the completed survey project 
(C:\Projects\9999999_SR01). 
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3. In the ProjectWise Explorer navigate to the location where you want to add the 

completed survey project  
(Documents > Central Offices > Aerial Engineering > Surveying >  
In-House Projects). 

 

4. Complete the folder drag and drop by left clicking on the main project folder and 
holding the mouse button down in the Windows Explorer, then while still holding the 
left mouse button down, drag the mouse pointer over the desired location in the 
ProjectWise Explorer and let up on the mouse button.   

 
5. At the Import Directories pop-up menu select to Include Subdirectories and leave the 

other settings as is. 
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6. Before creating the new folder in ProjectWise verify the storage location is correct by 
making sure the Parent Folder shown in the Import Directories menu is the desired 
location. 

 

7. Click OK and the project folder will be created in ProjectWise.  Refresh the display 
by hitting F5, then verify that the folder appears. 
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8. The new folder will have the same security settings as the folder it was added to.  For 
the survey storage locations in ProjectWise all non-survey users will have read access 
only. 

 
 
9. Verify the security setting on your project by right clicking on the main folder of the 

project and selecting properties. 

 

 

10. In the Properties menu select the Document Security tab.  The settings will be similar 
to those shown below with the exception of the list of names.  Your project may have 
additional users, but all should have only read access except for you and others in 
your survey section that you want to have write access to the data.  If additional 
groups need read access to the folder submit a Help Ticket when the need arises and 
CAD Support will make the necessary changes. 
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11. In the Properties menu select the Project\Folder Security tab.  The settings will be 
similar to those shown below with the exception of the list of names.  Your project 
may have additional users, but all should have only read access except for you and 
others in your survey section that you want to have write access to the data.  If 
additional groups need read access to the folder submit a Help Ticket when the need 
arises and CAD Support will make the necessary changes. 

 

 

5.3 Pick-Up Surveys and ProjectWise 
The following section goes through the procedure for adding pick-up survey data to a 
completed project that is stored in the ProjectWise datasource.  By following the 
procedures outlined in this section the original project folder will be kept as is, and a new 
“pick-up” subfolder will be added to it upon completion. 

5.3.1 Exporting the Existing Project from ProjectWise 
In order to create the Pick-Up project folder you will need to Export the existing project 
folder from ProjectWise as follows: 

1. In the ProjectWise Explorer right click on the main folder of the existing project you 
need for the pick-up, and select Export. 
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2. When the Folder Export Wizard menu appears, select Send to Folder – Creates 
unmanaged local copies, and then click Next. 

 

3. Then you need to specify the destination for the folder to be exported.  Use the 
Browse tab to select the appropriate folder, C:\Projects.  Verify that the boxes are 
checked as below, and then click Next. 
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4. Open the Windows Explorer and navigate to the exported folder. 

 

5. Right Click on the main folder and select Rename.  Then change the folder name as 
desired, an example would be adding ‘ – PickUp’ to the original Project folder name. 
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5.3.2 Importing the Completed Pick-Up Project into ProjectWise 
Once you are finished with the Pick-Up project you will need to import it as a subfolder 
into the original survey Project folder in ProjectWise.  Follow the same procedures as 
those outlined in Chapter 5.2.4Importing the Project into ProjectWise of this document. 
Make sure to Import the Pick-Up project folder as a sub-folder of the original Project 
Folder in ProjectWise, see below. 

 

 

5.4 Reference Scanning 
With MicroStation XM you can attach and modify references as you have in prior 
versions of MicroStation.  However, when you import those files into the ProjectWise 
datasource, ProjectWise has no knowledge of your reference attachments and the 
locations of your files.  Upon re-importing these files into ProjectWise, you will need to 
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rebuild your reference attachments for use.  References will be red in the Reference 
dialog. Exceptions to this issue are references in the same dgn file (i.e. Self references). 
 
As with the export process, ProjectWise also has tools available to rebuild your reference 
attachments once files have been brought into the datasource.  This tool can be found in 
ProjectWise Explorer, under the Tools Menu -> Scan References and Link Sets as 
illustrated in the following screenshot. 
 

 
 

The function of this tool is to rebuild any reference attachments that may have been 
created or modified outside of the ProjectWise environment.  While there are a large 
number of options and features that are available for use with this tool, we will be 
looking at the basic functions required to rebuild references for your MX data, with a 
brief highlight of the additional options. 
 
It is recommended that you only perform a reference scan upon having imported the 
project into ProjectWise at its completion. 
 
To perform a reference scan of your Survey Project folder: 

1. Start the Scan References and Link Sets Wizard PW->Tools->Scan 
References and Link Sets. 

2. The first panel is information regarding the usage of the tool, select next to 
continue to the next panel. 
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3. Specify your scan options: 

 
You may leave these options as shown, as they will rebuild any references 
you may have defined, select next to continue to the next panel. 

4. Next, you will need to select the folder for the project that you’d like 
have the references rescanned on.  Browse to and select the folder of 
your project that contains the dgn files, for most Survey projects this will 
be the Project Files folder.  Be sure to check the box next to the folder 
once you add it to the list.  Then select next to continue to the next panel. 

   
You may define multiple folders and locations in this step, however it is not 
recommended, as files with the same naming conventions may in-advertently 
be attached incorrectly. 
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5. You may skip configuring settings on the Master Folder Settings panel, 
select next to continue to the next panel. 

6. Priority Search:  This panel is used when you have multiple folder 
locations that you are scanning.  For the purposes of this project, we will 
not be using this, however, with this settings panel, you may set the order 
you’d like folders to be scanned.  The value of this is that when multiple 
locations are scanned, and have the same file name in each location, 
ProjectWise will use the reference from the first location it finds in the 
priority search.  In order to progress beyond this panel, you either need to 
define priority locations, or disable the priority search setting.  Left click 
on the Enable Priority Search check box to uncheck it.  Then select next 
to continue to the next panel. 

7. Proximity Search:  This setting is enabled by default, and is not able to be 
disabled.  This panel has a handful of settings described below the 
following illustration. 

 
In this panel, you may set the depth, of folders that you’d like to scan 
beneath or above your current scan location.  In most instances, you will 
only need to have your start location at your current folder and enable 
Search all Subfolders for References enabled.  This will contain your 
reference scan to the location which you’ve defined and any subfolders 
beneath it. Select Next to proceed 

8. On the Next Panel you may define the location for a log file if so needed.  
This will show the status of your reference scan, and what references have 
been repaired or not modified. Browse to the desired folder C:\Temp and 
type in a filename, scanrefs.log, and Left click on Save.  Then select next 
to continue to the next panel. 
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9. The final panel is purely information prior to running the reference scan.  
At this time, you may select Finish to begin the reference scan utility.  
Once completed the scanrefs.log file will be opened and you can review it. 

10. Close the log file and open one of the dgn files to ensure the references 
were properly re-attached. 

11. When you done looking at the file close MicroStation.  At the Check in 
prompt select free.  This will release the file without saving any changes. 

 
If you have any issues with Ref Scan file a Help Ticket. 
 
During the use of this tool, ProjectWise temporarily checks out each file in the scanned 
location in order to view and rebuild the references.  Once complete, it checks the files 
back in and makes them available for usage.  Depending on the quantity of files in the 
location, the usage of this utility may take a substantial amount of time. 
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Appendix B - Naming Conventions 
It is unlikely that we can stress enough the importance of using standard naming 
conventions.  It is sufficient to say however that good naming can eliminate numerous 
common problems. 
 
Note:  Throughout Appendix B, mcac is used to indicate a generic alignment 

B.1  Model Names 

Uniform model naming is necessary to insure consistency between users and to allow for 
continuity when projects are passed from one designer to another, or when multiple 
designers work on the same project.  Model naming is also important to insure consistent 
Cad Standards.  Uniform model naming insures models are associated with proper style 
sets.  The correct style set association will insure that strings are drawn appropriately and 
are placed on the correct levels.  The following list is compiled based on historically used 
models at INDOT and the automatic associations MX will assume based on model names 
(prefixes used for model names). 
Model Name Contents 
Des Proposed design Strings 
Des mcac Proposed design Strings for line mcac 
Des Alignments Proposed Alignments 
Des Culvert Box & Three Sided Culverts Structures 
Des Pipes Drainage Culverts Structures 
Des Drive Drives (if separated from other design strings) 
Des Subgrade mcac Subgrade model for line mcac 
Des TEMP RUNAROUND Temporary Runaround Strings 
Underdrain mcac Underdrains 
Hydraulic Surface mcac Ditches 
Sections mcac Cross Sections for line mcac 
Survey alignment Alignments Created by Survey Unit 
Volumes mcac Volumes calculated along mcac 
Topo Existing Topography information from Survey 

(provided by the Survey Unit) 
Topotria Triangulated Topo model 
Excont Existing Contours (provided by the Survey Unit) 
Prcont Proposed Contour Models 
Merge mcac Model containing design strings from mcac and 

topo strings outside the limits of the design 
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Des Section Alignments Alignments model with same Alignments as Des 
Alignments but only containing points where 
cross sections are to be cut. 

Alternate Naming, Used for larger more complex projects 
Des Roads Contains Proposed Design strings for all 

alignments 
Des Final Contains all proposed design strings with all 

gaps and editing completed 
Merge Roads Model containing design strings from all 

alignments and topo strings outside the limits of 
the design 

Merge Final Model containing design strings from all 
alignments and topo strings outside the limits of 
the design 

 
Note:  Not every project will need every type of suggested model nor is the user restricted 
to only create the models listed above.  Many additional temporary models can be created 
while using the GUI. 
 

B.2  General practices 

If triangulating any of the above models, add “tria” to the end of the model name. When 
creating proposed contours of any of the above models, add “Prcont” to the beginning of 
the model name. If merging models, add “Merge” to the beginning of the model name. 
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B.3  Model Names and Style Set Association 

It is desirable to use the above listed recommended model names in order to get the 
correct Plan Style Set / Feature Set associated with the correct model names.  The Plan 
Style Set / Feature Set Controls how elements are displayed in both standalone MX and 
MX in MicroStation.  The most important part of this is insuring that elements are placed 
on the appropriate levels.  It is important for users to check Model Defaults for any 
models used, especially those not using standard names.  A list of Model Names to Styles 
Sets equivalents is provided below based on the prefix of the Model name. 
 
Model Name Prefix Plan Style Set / Feature Sets 
Des INDOT Design.pss 
Underdrain  INDOT Design.pss 
Hydraulic Surface  INDOT Design.pss 
Sections INDOT Cross Sections.pss 
Survey alignment INDOT Survey Alignment.pss 
Topo INDOT DTopo.pss 
Topo (as Survey sees this) INDOT STopo.pss 
Topotria MFW Triangulation.pss 
Excont INDOT Existing Contours.pss 
Prcont INDOT Proposed Contours.pss 
Merge INDOT Merged Model.pss 
ISO MFW Isopachyte Triangulation.pts 
Prof MFW Profile.pss 
Terr MFW Simple Survey.pss 
BOUN MFW Boundary.pss 
VOL MFW Results.pss 
Corner INDOT Corner.pss 
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B.4  Input Files Names 

Name Description 
Drawtopo.inp Draws the surveyed topographical locations and 

contour surface 
Drawtopo_w-o_CONT.inp Draws the surveyed topographical locations without 

displaying the contour surface 
XSect.inp cuts and draws up cross sections along a master 

alignment, used to check triangulation model 
Findcorrupt.inp Searches for corrupt discontinuities and creates a 

DXF file 
Corrupt.inp Searches for corrupt discontinuities and creates a 

DXF file 
Triangle.inp Will create a triangulation of the topo model and 

creates topotria 
Des number.inp  ex. 0000000.inp Will create the topo model 
  
Create_survey_base_drawings.inp Creates the standard drawings necessary for surveys 
  
Sections.inp Draws typical cross sections for surveys 
  
Survey_alignment.inp Draws survey alignment and annotates it 
  
  
  
  
  
 
 
Note:  Template input files typically used by surveys are included in the Project Files 
folder of the template project.  All other input files are to be stored on the J:\Project 
drive (Unless you are using Arenium) even if working on MX locally.  MX remembers 
the path used, therefore, user will only need to browse to the J: drive location for input 
files once.   
As with model naming not every project will need every type of suggested input file nor 
is the user restricted to only create the input file listed above however, the users should 
use these guidelines to the benefit of all. 
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B.5  MicroStation Drawing Names 

 
Note:   Please abbreviate .dgn names as needed using the INDOT standard abbreviations  
ie.  Sht – Sheet, MOT - Maintenance of Traffic, 
n is used to denote the drawing number for drawings with multiple sheet numbers 001, 
002, 003, etc. 
 
Standard 2D Drawings (Non MX created) 
Drawing Names Descriptions Examples 
Sht Title Title sheet Sht Title.dgn 
Sht Index Index sheet (non-bridge) Sht Index.dgn 
Sht Typical n Typical section details Sht Typical.dgn 

Sht Typical 01.dgn 
Sht Typical 02.dgn 
Sht Typical n.dgn 

Sht Approach Det Bridge approach details Sht Approach Det.dgn 
Sht Plat1 n Survey Route plat Sht Plat1.dgn 

Sht Plat1 01.dgn 
Sht Plat1 02.dgn 
Sht Plat1 n.dgn 

Sht Plat3 n Survey Route plat with aerial 
photography included 

Sht Plat3.dgn 
Sht Plat3 01.dgn 
Sht Plat3 02.dgn 
Sht Plat3 n.dgn 

Sht Superelevation Superelevation diagrams Sht Superelevation 
Sht MOT n Maintenance of traffic details Sht MOT.dgn 

Sht MOT 01.dgn  
Sht MOT 02.dgn 
Sht MOT n.dgn 

Sht Channel Change Channel relocation details Sht Channel Change.dgn 
Sht Retaining Wall Retaining wall details Sht Retaining Wall 
Sht General Plan Bridge general plan Sht General Plan.dgn 
Sht Borings n Soil boring diagrams Sht Borings.dgn 

Sht Borings 01.dgn 
Sht Borings 02.dgn 
Sht Borings n.dgn 

Sht Bent n Bridge end bent details Sht Bent 1.dgn 
Sht Bent 2.dgn 
Sht Bent 1 & 2.dgn 
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Sht Bent Misc Miscellaneous bridge end 
bent details 

Sht Bent Misc.dgn 

Sht Pier n Bridge pier details Sht Pier 1.dgn 
Sht Pier 01.dgn  
Sht Pier 02.dgn 

Sht Pier Misc Miscellaneous bridge pier 
details  

Sht Pier Misc.dgn 

Sht Structural Steel Det Bridge structural steel details Sht Structural Steel Det 
Sht Beam n Bridge beam details Sht Beam.dgn 

Sht Beam 01.dgn 
Sht Beam 02.dgn 
Sht Beam n.dgn 

Sht Superstructure n Bridge superstructure details Sht Superstructure.dgn 
Sht Superstructure 01.dgn 
Sht Superstructure 02.dgn 
Sht Superstructure n.dgn 

Sht Misc Superstructure 
Det 

Miscellaneous bridge 
superstructure detail 

Sht Misc Superstructure 
Det.dgn 

Sht Railing Bridge railing details Sht Railing.dgn 
Sht Approach Slab Bridge approach slab details Sht Approach Slab.dgn 
Sht Framing Plan Bridge framing plan Sht Framing Plan.dgn 
Sht Coping Offsets Bridge coping offsets details Sht Coping Offsets.dgn 
Sht Layout Signals Layout Sketch Sht Layout.dgn 
Sht Existing Sign Plan Existing Signs plan Sht Existing Sign Plan.dgn 
Sht Proposed Sign Plan Proposed Signs plan Sht Proposed Sign Plan.dgn 
Sht RMA Sign Layout RMA’s Sht RMA Layout.dgn 
Sht Panel Sign Layout Panel Signs Sht Panel Sign Layout.dgn 
Sht Sign Cross Section Various Sign Cross Sections Sht Sign Cross Section.dgn 
Sht Guard Rail Detail Guard Rail Sign Detail Sht Guard Rail Detail.dgn 
Sht Panel 
Sign/Summary Post 

Panel Sign post Table Sht Panel Sign/Summary 
Post.dgn 

Sht Sign/Summary Post Sheet Sign Post Table Sht Sign/Summary Post.dgn 
Sht Light Plan Lighting Plan Sheet Sht Light Plan.dgn 
Sht Light Data Highway Light Data Sheet Sht Light Data.dgn 

 
Section Corner Pt Section Corner Point Section Corner Pt 0001-

0299.dgn 
Survey Control Pt Survey Centerline Point Survey Control Point 0500-

0699.dgn 
Section Plat Sheet Section Plat Sheet (8.5” x 

11”) 
Section Plat Sheet 01.dgn 
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Route Survey Plat Location Control Route 
Survey Plat 

Route Survey Plat 01.dgn 

Survey Alignment Book Survey Alignment for Field 
Book 

Survey Alignment Book 
01.dgn 

Present Structure Tie Present Structure Tie In (Top 
View) 

Present Structure Tie 01.dgn 

Present Structure Ord Present Structure Ordinance 
(Inlet) 

Present Structure Ord 01.dgn 

Survey Alignment Book Survey Alignment for Field 
Book 

Survey Alignment Book 
01.dgn 

Present Structure Tie Present Structure Tie In (Top 
View) 

Present Structure Tie 01.dgn 

Present Structure Ord Present Structure Ordinance 
(Inlet) 

Present Structure Ord 01.dgn 

 
 
Standard Base Drawings (MX & MXDRAW created) 
Drawing Names / 
Logical Names 

Descriptions / 
Reference Descriptions 

Examples 

Survey Alignment Survey Centerline Survey Alignment.dgn 
Survey Section Corner US Government Section 

Corners 
Survey Section Corner.dgn 

Survey Contours Survey Existing Contours Survey Contours.dgn 
Survey Topography Survey Existing 

Topography 
Survey Topography.dgn 

Survey Triangulation Existing Triangulation Survey Triangulation.dgn 
Explan scale 
 

Design Existing 
Topography 

Explan 50.dgn 
Explan 100.dgn 

Excont scale Survey Existing Contours Excont 50.dgn 
Excont 100.dgn 

Prplan scale  Proposed Design Strings Prplan 50.dgn 
Prplan 100.dgn 

Prcont scale Proposed Contours Prcont 50.dgn 
Prcont 100.dgn 

RW Existing scale Existing Right of Way RW Existing 50.dgn 
RW Existing 100.dgn 

Annotate Alignment 
mcac scale 

Proposed  Alignment 
Annotation 

Annotate alignment mcac 50.dgn 
Annotate alignment mcac 100.dgn

Annotate Survey 
Alignment mcac scale 

Survey Alignment 
Annotation  

Annotate survey alignment mcac  
50.dgn 
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Annotate station offset 
mcac scale 

Annotation of Survey 
points with station and 
offset 

Annotate station offset mcac 
50.dgn 

Annotate survey points 
mcac scale 

Annotation of Survey 
points 

Annotate survey points mcac 
50.dgn 

 
 
Standard Sheet Drawings (MX & MXDRAW created) 
Drawing Names Descriptions Examples 
Planprofile mcac scale n Plan & profiles drawings  Planprofile mcac 50 001.dgn  

Planprofile mcac 50 002.dgn 
Planprofile mcac 50 n.dgn 

Layout mcac scale n Bridge layout sheet Layout mcac 50 001.dgn  
Layout mcac 50 002.dgn 
Layout mcac 50 n.dgn 

Const det mcac scale n Construction details  
drawings 

Const det mcac 50 001.dgn  
Const det mcac 50 002.dgn 
Const det mcac 50 n.dgn 

Pvmt Markings scale n Pavement marking 
details 

Pvmt Markings 50.dgn 
Pvmt Markings 50 01.dgn  
Pvmt Markings 50 02.dgn 
Pvmt Markings 50 n.dgn 

Runaround mcac scale n Temporary Runaround 
plan profile drawings.   

Runaround mcac 50 001.dgn  
Runaround mcac 50 002.dgn 
Runaround mcac 50 n.dgn 

TEC det mcac scale n Temporary Erosion 
Control details 

TEC det mcac 50 01.dgn 
TEC det mcac 50 02.dgn  
TEC det mcac 50 n.dgn 

Intersection Det scale n Intersection details Intersection det 50 n.dgn 
 
For Sheets created by MXDRAW modify the names of sheet drawings created and avoid 
the use of the default naming convention set by MXDRAW. 
 
For all of the above MX & MXDRAW created sheets, the alignment name, scale, & sheet 
number indicates which alignment, scale, & sheet number is reflected.  Following this 
convention will allow easy differentiation between alignments and also allow the correct 
.pcf to be selected. 
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Cross Section Drawings (MX Input File & MX in MicroStation created) 
Drawing Names Descriptions Examples 
Sectionsmcac n Cross sections drawings  Sectionsmcac_dr_001.dgn 

Sectionsmcac_dr_002.dgn 
Sectionsmcac_dr_003.dgn 
Sectionsmcac_dr_n.dgn 

Sht sect text mcac n Cross section text 
drawings used to add text 
to  cross sections without 
modifying the original 
drawing 

Sht sect text mcac_dr_001.dgn 
Sht sect text mcac_dr_002.dgn 
Sht sect text mcac_dr_003.dgn 
Sht sect text mcac_dr_n.dgn 

 
For each cross section drawing created, the sheet used to plot and edit is the text drawing. 
For example: Sht text sectionsmcac n.  This drawing would have a border frame drawing 
referenced into it and a Sectionsmcac drawing referenced into it.  By preserving text in 
text drawings, users are prevented from losing annotation text if new cross section 
drawings (Sectionsmcac) are created.  These composite text drawings also allow drive 
profiles to be added easily added through the use of reference files.  Variations on the 
cross section drawing names Sectionsmcac can be used if needed (ie. Sectionsmcac Ph1). 
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Border Frame Drawings  
(used with drawings originating from MX Input File & MX in MicroStation) 
 
In this version of MX, all of the borders have been moved into Bdr INDOT All.dgn 
except for the xsec borders.  A listing of all the borders in this file is located below. 
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Appendix C - Drawtopo.inp 

C.1  Drawtopo input file 

To amend any variables for existing cross sections, use the PFE Editor to open the file 
Drawtopo.inp 
 
The contents of this file are: 
 
MOSS  -  STANDARD SURVEY DRAWING INPUT FILE 
 
NEWDPF,TOPO.DPW 
 
DRAW,TOPO 
 
017DMS DMS 
 
018IMP 
 
019 
019,,4=-1 
900,PLANDRAW 
FD='',SL=400,SW=400,SC=100,TC=YELL,TR=TRUN,LC=BLUE,LA=NOLA,GR=NOGR 
808,,U 0 ,,10.50,2,0.7,0.25,,,0.25 
 
   ***   STRING COLORS USED   *** 
 
   NOTE : DL STRING ALREADY DEFINED ABOVE, CURRENT LINE COLOR = BLUE 
805,BLUE 
825,DL 
825,IS 
825,SL 
825,SY 
825,SM 
825,UD 
825,UW 
825,WA 
825,WE 
825,WF 
 
805,CYAN 
825,BOUN 
825,DC 
825,DF 
825,DP 
 
805,GREE 
825,BA 
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825,BC 
825,BD 
825,BE 
825,BF 
825,BG 
825,BH 
825,BM 
825,BN 
825,BP 
825,BR 
825,BS 
825,BT 
825,BW 
825,BZ 
825,CB 
825,CE 
825,CG 
825,CM 
825,CP 
825,CS 
825,DS 
825,EC 
825,EG 
825,EL 
825,EM 
825,ES 
825,FB 
825,FC 
825,FE 
825,FF 
825,FI 
825,FM 
825,FO 
825,FP 
825,FR 
825,FS 
825,FV 
825,FW 
825,GA 
825,GD 
825,HD 
825,HE 
825,HR 
825,LE 
825,LC 
825,LF 
825,LS 
825,NG 
825,OB 
825,OC 
825,OD 
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825,OM 
825,OR 
825,OS 
825,OT 
825,RA 
825,RB 
825,RD 
825,RO 
825,RP 
825,RS 
825,RX 
825,RW 
825,SC 
825,SK 
825,SD 
825,SP 
825,SW 
825,TC 
825,TB 
825,TD 
825,TH 
825,TS 
825,UC 
825,UR 
825,UX 
825,UZ 
825,WG 
825,WL 
825,WW 
 
805,ORAN 
825,RC 
825,ST 
825,UT 
 
805,RED 
825,AA 
825,AI 
825,AS 
825,CO 
825,CD 
825,DR 
825,EP 
825,ET 
825,M 
825,RR 
825,SG 
825,TA 
825,UE 
825,US 
825,Z 
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805,YELL 
825,CT 
825,GP 
825,GI 
825,OH 
825,UG 
825,UH 
825,UP 
825,UV 
 
   ***   MACRO SYMBOLS USED   *** 
 
805,BLUE 
861,PCBD,TRIA,GRMH,0.15,,,0.15,,,0.0 
861,PCIS,SQUA,REMH,0.15,,,0.15,,,0.0 
861,PCRB,SQUA,REMH,0.15,,,0.15,,,0.0 
861,PCST,TOPC,STNG,0.05,,,0.05,,,0.0 
861,PDID,TRIA,GRMH,0.15,,,0.15,,,0.0 
863,PHPT,1,,0.06,10=0 
861,PHYD,FIRE,HYDR,0.15,,,0.06,,,0.0 
861,PMHD,ROUN,DMHL,0.12,,,0.07,,,0.0 
861,PMHO,ROUN,DMHL,0.12,,,0.07,,,0.0 
861,PMHW,ROUN,DMHL,0.12,,,0.07,,,0.0 
863,PPON,3,,0.06,10=0 
863,PSHD,1,,0.06,10=0 
861,PSWP,ROUN,DWCR,0.12,,,0.07,,,0.0 
861,PVAC,ROUN,DWCR,0.12,,,0.07,,,0.0 
863,PVBX,0,,0.06,10=0 
861,PWAM,WATE,RMTR,0.15,,,0.07,,,0.0 
863,PVBX,0,,0.06,10=0 
863,PWAR,1,,0.06,10=0 
863,PWEL,10,,0.06,10=0 
863,PWGT,10,,0.06,10=0 
863,PWLP,10,,0.06,10=0 
861,PWSO,STOP,VALV,0.12,,,0.07,,,0.0 
863,PWTR,4,,0.06,10=0 
 
805,GREE 
861,PBTH,TELE,CBOX,0.15,,,0.15,,,0.0 
863,PBUS,11,,0.05,10=0 
861,PCCT,SQMH,NOID,0.15,,,0.15,,,0.0 
861,PDEL,DELN,POST,0.09,,,0.05,,,0.0 
863,PEDC,0,,0.06,10=0 
863,PGLT,0,,0.06,10=0 
863,PGPT,0,,0.06,10=0 
863,PGRS,3,,0.07,10=0 
863,PGUY,8,,0.05,10=0 
863,PHHL,0,,0.06,10=0 
863,PJNT,0,,0.06,10=0 
863,PLIT,1,,0.06,10=0 
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863,PLPT,1,,0.06,10=0 
863,PLTD,1,,0.06,10=0 
863,PLTJ,1,,0.06,10=0 
863,PMAP,1,,0.06,10=0 
861,PMHC,ROUN,DMHL,0.12,,,0.07,,,0.0 
861,PMHI,ROUN,DMHL,0.12,,,0.07,,,0.0 
861,PPBX,ROUN,DMHL,0.12,,,0.07,,,0.0 
863,PPOL,0,,0.06,10=0 
863,PPSN,11,,0.06,10=0 
863,PPST,11,,0.06,10=0 
863,PPWP,0,,0.06,10=0 
863,PSAT,0,,0.06,10=0 
863,PSGL,7,,0.06,10=0 
863,PSGN,7,,0.06,10=0 
863,PSLD,0,,0.06,10=0 
863,PSND,7,,0.06,10=0 
863,PSTP,10,,0.06,10=0 
861,PTCS,CONI,FERS,0.10,,,0.05,,,0.0 
861,PTDS,TREE,SYMB,0.10,,,0.05,,,0.0 
863,PTEL,6,,0.06,10=0 
863,PTER,5,,0.06,10=0 
863,PTFP,11,,0.06,10=0 
863,PTGP,5,,0.06,10=0 
863,PTOW,5,,0.06,10=0 
863,PTSP,5,,0.06,10=0 
863,PTUB,5,,0.06,10=0 
863,PTVR,5,,0.06,10=0 
863,PWED,3,,0.06,10=0 
863,PWOD,3,,0.06,10=0 
 
805,ORAN 
861,PANC,GUYA,NCHR,0.05,,,0.05,,,0.0 
863,PASE,3,,0.07,10=0 
863,PASP,3,,0.07,10=0 
861,PBMK,OSTR,GSTN,0.04,,,0.04,,,0.0 
861,PCAN,PRST,LCAN,0.09,,,0.05,,,0.0 
863,PCCP,0,,0.06,10=0 
863,PCCR,0,,0.06,10=0 
861,PCON,OSTR,GSTN,0.04,,,0.04,,,0.0 
863,PCRS,3,,0.07,10=0 
863,PCRT,3,,0.07,10=0 
863,PDRT,3,,0.06,10=0 
863,PEDT,0,,0.06,10=0 
863,PELV,3,,0.05,10=0 
863,PFEL,9,,0.06,10=0 
863,PFLP,1,,0.06,10=0 
863,PFOM,3,,0.06,10=0 
863,PGBD,9,,0.06,10=0 
863,PGMW,1,,0.06,10=0 
861,PGPS,OSTR,GSTN,0.04,,,0.04,,,0.0 
861,PHUB,OSTR,GSTN,0.04,,,0.04,,,0.0 



Appendix C -   Drawtopo.inp

 

 
INDOT Plan Production - 
Surveys  

 6 

 

861,PIDT,OSTR,GSTN,0.04,,,0.04,,,0.0 
861,PIFC,OSTR,GSTN,0.04,,,0.04,,,0.0 
863,PMAT,3,,0.05,10=0 
861,PMAG,2,,0.06,10=0 
863,PMBX,9,,0.06,10=0 
861,PMHT,ROUN,DMHL,0.12,,,0.07,,,0.0 
861,PMON,OSTR,GSTN,0.04,,,0.04,,,0.0 
863,PMUL,3,,0.06,10=0 
861,PNGS,OSTR,GSTN,0.04,,,0.04,,,0.0 
861,PRDN,2,,0.06,10=0 
861,PRSL,ROUN,DTCR,0.12,,,0.07,,,0.0 
861,PRSN,ROUN,DTCR,0.12,,,0.07,,,0.0 
861,PSBD,ROUN,DTCR,0.12,,,0.07,,,0.0 
861,PSLM,ROUN,DTCR,0.12,,,0.07,,,0.0 
861,PSTK,ROUN,DTCR,0.12,,,0.07,,,0.0 
863,PSTN,3,,0.06,10=0 
861,PSTO,OSTR,GSTN,0.04,,,0.04,,,0.0 
861,PTLM,ROUN,DTCR,0.12,,,0.07,,,0.0 
861,PTXT,ROUN,DTCR,0.12,,,0.07,,,0.0 
861,PUSC,OSTR,GSTN,0.04,,,0.04,,,0.0 
861,PUSG,OSTR,GSTN,0.04,,,0.04,,,0.0 
 
805,RED 
861,PBRP,BRAS,SPLG,0.09,,,0.06,,,0.0 
861,PBSP,BOAT,SPIK,0.09,,,0.05,,,0.0 
863,PCCE,0,,0.06,10=0 
863,PDRH,0,,0.06,10=0 
863,PEDE,0,,0.06,10=0 
863,PELB,0,,0.06,10=0 
861,PELM,ROUN,DMHL,0.10,,,0.06,,,0.0 
863,PELR,0,,0.06,10=0 
863,PGRV,3,,0.07,10=0 
863,PGVT,1,,0.06,10=0 
863,PIP0,2,,0.06,10=0 
863,PIP2,2,,0.06,10=0 
863,PIP3,2,,0.06,10=0 
863,PIP4,2,,0.06,10=0 
863,PIP6,2,,0.06,10=0 
863,PIP8,2,,0.06,10=0 
863,PMBD,16,,0.04,10=900000 
863,PMBM,16,,0.04,10=900000 
861,PMHE,ROUN,DMHL,0.12,,,0.07,,,0.0 
861,PMHS,ROUN,DMHL,0.12,,,0.07,,,0.0 
863,POWN,12,,0.05,10=0 
863,PPIN,2,,0.06,10=0 
863,PPKN,2,,0.06,10=0 
863,PRE0,2,,0.06,10=0 
863,PRE2,2,,0.06,10=0 
863,PRE3,2,,0.06,10=0 
863,PRE4,2,,0.06,10=0 
863,PRE5,2,,0.06,10=0 
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863,PRE6,2,,0.06,10=0 
863,PRE7,2,,0.06,10=0 
863,PRE8,2,,0.06,10=0 
863,PROC,3,,0.06,10=0 
863,PRRS,2,,0.06,10=0 
863,PZZZ,8,,0.05,10=0 
 
805,YELL 
863,PACU,0,,0.06,10=0 
863,PCEL,3,,0.07,10=0 
863,PEDG,0,,0.06,10=0 
861,PGAM,ROUN,DGCR,0.09,,,0.06,,,0.0 
861,PGFC,ROUN,DGCR,0.09,,,0.06,,,0.0 
861,PGSO,ROUN,DGCR,0.09,,,0.06,,,0.0 
861,PGWL,ROUN,DGCR,0.09,,,0.06,,,0.0 
861,PGWS,ROUN,DGCR,0.09,,,0.06,,,0.0 
861,PMHG,ROUN,DMHL,0.12,,,0.07,,,0.0 
861,PPSO,ROUN,DGCR,0.12,,,0.07,,,0.0 
861,PPVT,ROUN,DGCR,0.12,,,0.07,,,0.0 
 
805ORAN                                                                          
808    N 0        0.046     3.000     0.750  0.000                              
806,50                                                                         
825PSSADETA                                                                      
 
805,GREY 
863,PBRK,11,,0.05,10=0 
 
808    N 01       0.015     0.000     0.750   0.000                              
806BLAC                                                                          
869PNUM           4.000                       0.005                      
450000  
805BLAC 
019 
019,P,4=-1                                                                    
863    3          0.030                                                  
450000  
808    N 01       0.05      0.000     0.750   0.000  
869,4=-1,7=-0.2 
999 
 
DRAW,CROSS 
 
801OVER 
805ORAN 
825,T 
 
999 
 
MOSS 
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DRAW,EXCONT                                                                
 
801OVER 
805GREY                                                                       
825D                                                                             
805PINK                                                                          
808    N 01       0.050     0.000     0.750   0.000                              
806BLAC                                                                          
8250   CONP      15.000                      -1.000                              
 
999 
 
DISPLAY 
 
FINISH 
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Appendix D - Triangle.inp 

D.1  Triangulation Input File 

To amend any variables for existing cross sections, use the PFE Editor to open the file 
Triangle.inp 
 
The contents of this file are: 
 
 
THIS FILE IS TO BE USED TO CREATE THE TRIANGULATION MODEL (TOPOTRIA) 
AND THE SURFACE MODEL (EXCONT). IT WILL ALSO CREATE THE TRIANGULATION 
ERROR FILE (TRIANGLE.ERR) TO BE CHECKED FOR STRING CROSSING ERRORS. 
ALSO, PLEASE NOTE NEAR THE BOTTOM OF THIS FILE AS TO THE EXISTANCE OF A 
BOUNDARY STRING. READ THE NOTES AS TO WHICH LINES ARE TO BE USED FOR 
YOUR PARTICULAR SITUATION. 
 
   Note: This input file is used by the survey department staff. It 
   requires some knowledge of what we do and what is to be used for 
   triangulation.  Use this file at your own risk. It is not guaranteed 
   to be free from errors or omissions. 
 
   ------------------------------------------------------------------- 
   ***** THE FOLLOWING LINE OPENS THE TRIANGLE.ERR FILE AND ******** 
   ************** ECHOES THE OUTPUT TO THE SCREEN AS WELL*********** 
   ------------------------------------------------------------------- 
 
SUBS 
SYSDEL,TRIANGLE.ERR 
999 
OUTPUT,TRIANGLE.ERR,TERM 
 
MOSS 
DELETE,EXCONT 
CREATE,EXCONT 
 
DELETE,TOPOTRIA 
CREATE,TOPOTRIA 
 
COMPRESSMODELFILE 
 
   ------------------------------------------------------------------- 
   THE FOLLOWING LINES CREATE THE TRIANGLES FOR THE GROUND MODEL AND 
   MASK OUT STRINGS NOT TO BE USED FOR THE TRIANGLES 
   ------------------------------------------------------------------- 
 
TRIANGLE,TOPO,TOPO                                     
TRIANGLE,TOPOTRIA                
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019 
019,A,4=-1 
019,BA,4=1 
   019,BC,4=1 
019,BC,4=-1 
019,BE,4=-1 
019,BF,4=-1 
019,BG,4=-1 
019,BH,4=-1 
   019,BM,4=-1 
019,BN,4=-1 
   019,BOUN,4=-1 
019,BP,4=-1 
019,BR,4=-1 
019,BS,4=-1 
   019,BT,4=-1 
019,BW,4=1 
 
 
019,CM,4=-1 
 
019,CP,4=-1 
 
019,DR,4=-1 
019,DS,4=-1 
 
019,ET,4=-1 
 
019,FC04,4=1 
019,FC06,4=1 
019,F,4=2 
   019,FB,4=-1 
   019,FC,4=-1 
   019,FV,4=-1 
   019,FE,4=-1 
   019,FF,4=-1 
   019,FI,4=-1 
   019,FM,4=-1 
   019,FO,4=-1 
   019,FP,4=-1 
   019,FR,4=-1 
   019,FS,4=-1 
   019,FW,4=-1 
  
019,GA,4=-1 
019,GD,4=-1 
   019,GI,4=-1 
019,GL,4=-1 
019,GP,4=-1 
019,GR,4=-1 
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019,HD01,4=1 
019,HD,4=-1 
019,HE,4=-1 
 
019,LC,4=-1 
019,LS,4=1 
 
019,M,4=-1 
 
   019,NG,4=1 
 
019,OR,4=2 
 
019,PELV,4=1 
019,PBRK,4=1 
   019,PMAT,4=1 
019,PCEL,4=-1 
019,P,4=-1 
   019,PANC,4=-1 
   019,PASE,4=-1    
   019,PBMK,4=-1 
   019,PBRP,4=-1 
   019,PBSP,4=-1 
   019,PBTH,4=-1 
   019,PBUS,4=-1 
   019,PCAN,4=-1 
   019,PCBD,4=-1 
   019,PCCT,4=-1 
   019,PCEL,4=-1 
   019,PCIS,4=-1 
   019,PCON,4=-1 
   019,PCRB,4=-1 
   019,PCST,4=-1 
   019,PDID,4=-1 
   019,PDRH,4=-1 
   019,PEDC,4=-1 
   019,PEDE,4=-1 
   019,PEDG,4=-1 
   019,PEDT,4=-1 
   019,PELM,4=-1 
   019,PELR,4=-1 
   019,PFEL,4=-1 
   019,PFLP,4=-1 
   019,PFOM,4=-1 
   019,PGBD,4=-1 
   019,PGAM,4=-1 
   019,PGFC,4=-1 
   019,PGLT,4=-1 
   019,PGMW,4=-1 
   019,PGPT,4=-1 
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   019,PGSO,4=-1 
   019,PGUY,4=-1 
   019,PGWL,4=-1 
   019,PGWS,4=-1 
   019,PHHL,4=-1 
   019,PHYD,4=-1 
   019,PJNT,4=-1 
   019,PLIT,4=-1 
   019,PLPT,4=-1 
   019,PLTD,4=-1 
   019,PLTJ,4=-1 
   019,PIP2,4=-1 
   019,PIP3,4=-1 
   019,PIP4,4=-1 
   019,PIP6,4=-1 
   019,PIP7,4=-1 
   019,PIP8,4=-1 
   019,PIP0,4=-1 
   019,PMAP,4=-1 
   019,PMAT,4=-1 
   019,PMBX,4=-1 
   019,PMBD,4=-1 
   019,PMBM,4=-1 
   019,PMHC,4=-1 
   019,PMHD,4=-1 
   019,PMHE,4=-1 
   019,PMHG,4=-1 
   019,PMHO,4=-1 
   019,PMHS,4=-1 
   019,PMHT,4=-1 
   019,PMHW,4=-1 
   019,POWN,4=-1 
   019,PPBX,4=-1 
   019,PPOL,4=-1 
   019,PPSO,4=-1 
   019,PPST,4=-1 
   019,PPWP,4=-1 
   019,PPVT,4=-1 
   019,PRE2,4=-1 
   019,PRE3,4=-1 
   019,PRE4,4=-1 
   019,PRE5,4=-1 
   019,PRE6,4=-1 
   019,PRE7,4=-1 
   019,PRE8,4=-1 
   019,PRE0,4=-1 
   019,PRSL,4=-1 
   019,PRSN,4=-1 
   019,PSAT,4=-1 
   019,PSBD,4=-1 
   019,PSGL,4=-1 
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   019,PSGN,4=-1 
   019,PSLM,4=-1 
   019,PSND,4=-1 
   019,PSSA,4=-1 
   019,PSSC,4=-1 
   019,PSST,4=-1 
   019,PSTK,4=-1 
   019,PSTP,4=-1 
   019,PSWP,4=-1 
   019,PTCS,4=-1 
   019,PTDS,4=-1 
   019,PTEL,4=-1 
   019,PTGP,4=-1 
   019,PTER,4=-1 
   019,PTLM,4=-1 
   019,PTOW,4=-1 
   019,PTSP,4=-1 
   019,PTUB,4=-1 
   019,PTVR,4=-1 
   019,PTXT,4=-1 
   019,PTVR,4=-1 
   019,PVAC,4=-1 
   019,PWAM,4=-1 
   019,PWEL,4=-1 
   019,PWGT,4=-1 
   019,PWSO,4=-1 
   019,PWTR,4=-1 
 
 
019,RA,4=-1 
019,RP,4=2 
019,RR,4=-1 
019,RB,4=-1 
   010,RW,4=1 
 
019,SC,4=-1 
019,SG,4=-1 
019,SD,4=-1 
019,ST,4=-1 
019,SW,4=-1 
019,SM,4=-1 
019,SP37,4=1 
019,SP,4=-1 
 
019,TC,4=2 
019,TD,4=2 
019,TF,4=-1 
019,TH,4=-1 
  
019,U,4=-1 
   019,UC,4=-1 



Appendix D -   Triangle.inp

 

 
INDOT Plan Production - 
Surveys  

 6 

 

   019,UD,4=-1 
   019,UE,4=-1 
   019,UG,4=-1 
   019,UP,4=-1 
   019,UR,4=-1 
   019,US,4=-1 
   019,UT,4=-1 
   019,UW,4=-1 
   019,UX,4=-1 
 
019,WE,4=1 
019,WL14,4=1 
019,WL15,4=1 
019,W,4=2 
   019,WA,4=-1 
   019,WF,4=1 
   019,WL,4=-1 
    
 
   ------------------------------------------------------------------- 
*** USE THE FOLLOWING LINE IF THERE IS NO BOUNDARY STRING ***** 
   ------------------------------------------------------------------- 
 
960,,,TRIA 
 
   ------------------------------------------------------------------- 
   ***** USE THE FOLLOWING LINE IF THERE IS A  BOUNDARY STRING ***** 
   ------------------------------------------------------------------- 
 
   960,BNDR,,TRIA                                                      
 
   ------------------------------------------------------------------- 
  ** USE THE FOLLOWING LINE IF THERE IS NO BOUNDARY STRING ** 
   ------------------------------------------------------------------- 
 
961,,TRIA,TRIA,10=1 
 
   ------------------------------------------------------------------- 
   ***** USE THE FOLLOWING LINE IF THERE IS A  BOUNDARY STRING ***** 
   ------------------------------------------------------------------- 
 
   961,BNDR,TRIA,TRIA,10=1 
 
999  
 
 
   ------------------------------------------------------------------- 
   THE FOLLOWING LINE CLOSES THE OUTPUT FILE TRIANGLE.ERR  
   ------------------------------------------------------------------- 
 
OUTPUT 
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MOSS 
 
   ------------------------------------------------------------------- 
   MAJOR OPTION SURFACE IS USED TO CREATE THE CONTOUR STRINGS  
   ------------------------------------------------------------------- 
 
SURFACE,TOPOTRIA,TOPO                                     
SURFACE,EXCONT                                                                   
 
   ------------------------------------------------------------------- 
   ***** USE THE FOLLOWING LINE FOR JOBS DONE IN ENGLISH ***** 
   ***** The following line determines the interval for ***** 
   ************ the secondary contour interval. ************* 
   ------------------------------------------------------------------- 
 
970,TRIA,,,0.5                                                
 
   -------------------------------------------------------------------- 
   ***** USE THE FOLLOWING LINE FOR JOBS DONE IN METRIC ***** 
   ***** The following line determines the interval for ***** 
   ************ the secondary contour interval. ************* 
   -------------------------------------------------------------------- 
 
   970,TRIA,,,0.2                                                
 
999  
 
FINISH 
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Appendix E - Sections.inp 

E.1  Cross Sections Input File 

To amend any variables for existing cross sections, use the PFE Editor to open the file 
Sections.inp 
 
The contents of this file are: 
 
mx 
 
moss 
 
delete,CROSS 
create,CROSS 
 
section,topotria,survey alignment 
section,CROSS 
178,mc00,tria,t,10,,,-50,,,50 
999 
 
newdpw,CROSS 
 
draw,CROSS,survey alignment 
900,sect 
cs=t,rs=mc00,lgt=nogr 
999 
 
display 
 
FINISH 
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Appendix F - create_survey_base_drawings.inp 

F.1  Create Survey Base Drawings Input File 

To amend any variables for existing cross sections, use the PFE Editor to open the file 
create_survey_base_drawings.inp. Note the default scale is 200. 
 
The contents of this file are: 
 
MX 
   create_survey_base_drawings.inp 
   ******************************************************************* 
   survey alignment 
   create new plan display / cad drawing to contain the Survey 
   Alignment elements 
NEWD,Survey Alignment.dpw 
   specify model to draw 
DRAW,SURVEY ALIGNMENT 
   define coordinate relationship ... select drawing scale 
803,PLAN,,,,,,200. 
   draw with style set specified in following 001 option 
850,,,,1. 
001,PublicStyles\INDOT Survey Alignment.pss 
999 
   updates display  
DISPLAY 
   ******************************************************************* 
   corner 
   create new plan display / cad drawing to contain the Corner elements 
NEWD,Survey Section Corner.dpw 
   specify model to draw  
DRAW,CORNER 
   define coordinate relationship ... select drawing scale 
803,PLAN,,,,,,200. 
   draw with style set specified in following 001 option 
850,,,,1. 
001PublicStyles\indot corner.pss 
999 
   updates display  
DISPLAY 
   ******************************************************************* 
   EXCONT 
   create new plan display / cad drawing to contain the EXCONT elements 
NEWD,Survey Contours.dpw 
   specify model to draw  
DRAW,EXCONT 
   define coordinate relationship ... select drawing scale 
803,PLAN,,,,,,200. 
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   draw with style set specified in following 001 option 
850,,,,1. 
001,PublicStyles\indot existing contours.pss 
999 
   updates display  
DISPLAY 
   ******************************************************************* 
   TOPO 
   create new plan display / cad drawing to contain the TOPO elements 
NEWD,Survey Topography.dpw 
   specify model to draw  
DRAW,TOPO 
   define coordinate relationship ... select drawing scale 
803,PLAN,,,,,,200. 
   draw with style set specified in following 001 option 
850,,,,1. 
001,PublicStyles\indot dtopo.pss 
999 
   updates display  
DISPLAY 
   ******************************************************************* 
   TOPOTRIA 
   create new plan display / cad drawing to contain the TOPOTRIA 
elements 
NEWD,Survey Triangulation.dpw 
   specify model to draw  
DRAW,TOPOTRIA 
   define coordinate relationship ... select drawing scale 
803,PLAN,,,,,,200. 
   draw with style set specified in following 001 option 
850,TRIA 
001,PublicStyles\mfw triangulation.pts 
999 
   updates display  
DISPLAY 
   ******************************************************************* 
   RP TOPO 
   create new plan display / cad drawing to contain the RP TOPO 
elements 
NEWD,Survey RP Topography.dpw 
   specify model to draw  
DRAW,TOPO 
   define coordinate relationship ... select drawing scale typically 1 
to 200 for 
   the Route Plat sheet 
803,PLAN,,,,,,200. 
   draw with style set specified in following 001 option 
850,,,,1. 
001,PublicStyles\INDOT RPTopo.pss 
999 
   updates display  
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DISPLAY 
    To keep the elements in separate MicroStation drawings place 
    the finish to the left 
   fini 
 
   ******************************************************************** 
   Survey RoutePlat All 
   - contains all the model information from TOPO, CORNER, SURVEY 
ALIGNMENT  
     etc. required to make the Route Plat drawings 
 
   create new plan display / cad drawing to contain the RP TOPO 
elements 
NEWD,Survey RoutePlat All.dpw 
 
   specify model to draw  
DRAW,TOPO 
   define coordinate relationship ... select drawing scale typically 1 
to 200, or 1 to 100 for 
   the Route Plat sheet 
803,PLAN,,,,,,200. 
   draw with style set specified in following 001 option 
850,,,,1. 
001,PublicStyles\INDOT RPTopo.pss 
999 
 
   add corners model 
   specify model to draw  
DRAW,CORNER 
801,OVERFREE 
850,,,,1. 
001,PublicStyles\indot corner.pss 
999 
 
   add survey alignments model 
   specify model to draw  
DRAW,SURVEY ALIGNMENT 
801,OVERFREE 
   draw with style set specified in following 001 option 
850,,,,1. 
001,PublicStyles\INDOT Survey Alignment.pss 
999 
  
   add whatever other models necessary 
 
   updates display  
DISPLAY 
finish 
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Appendix G - Level Libraries 
Please see the CAD FAQ Page for the most up to date information. 
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Appendix H - MicroStation Libraries 

H.1  DGN Library 

A DGN library is a DGN file used to store: 
• Text styles 
• Dimension styles 
• Levels (Filters) 
• Models 

These are shared within the workgroup as standards.  A DGN library is sometimes 
referred to as a DGN lib (pronounced with a long 'i'). The recommended file extension 
for this file is *.dgnlib. Cells/Models, dimension styles, levels, and text styles are created 
in a DGN library using MicroStation tools, the same way they are created in a DGN file. 
Appendix E shows the various levels for each of the dgnlibs created for INDOT based on 
a project type (i.e. imperial or metric units).  By selecting the correct seed file and 
INDOT workspace UCF (User) the appropriate dgnlib will be used.  It is a way for us to 
easily define and use CAD Standards for text, dimensions, levels, naming etc.  
 
The indot_cad.dgnlib is located at… 
X:\WRKSPC_INDOT_XM\Workspace\Standards\dgnlib\indot_cad.dgnlib   (read only) 

H.2  Text Styles 

What is a Text Style? 
MicroStation supports text styles and provides an interface for constructing text using 
available system fonts and a wide variety of text attributes. A text style comprises a group 
of text attributes, such as font type, width, height, and color. Text styles enable you to 
place text within a model in a consistent and automated manner. 
The following fonts are supported natively in MicroStation: 
Traditional MicroStation fonts 
TrueType fonts 
AutoCAD Shape fonts (.shx)  
Tip1.  Fonts are not embedded in the DGN file.  
Tip2.  If a specific font is not found on the system, MicroStation substitutes font #127, 
Fast Font. 
Tip3.  If a Text Style changes in a Text Style library, Text Styles placed in DGN files 
prior to the change are not automatically updated in the DGN files. To update a DGN file 
to reflect the changes in the Text Style library, use the dgnlib update text styles from the 
text styles dialog. 
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INDOT Text Styles 
Text styles at INDOT have been changed in this new workspace to be more in line with 
their size and use rather than related to the section of INDOT as in previous workspaces.   
You will notice that the Text Styles are now using True Type fonts and only a few 
Bentley fonts.  This gives us more flexibility with Bold and Italics settings.  The Bentley 
fonts will be used whenever special characters are needed.  The following tables will 
show you the settings for each Text Style.   
 

(See Appendix H for Text Style – Sheet Use chart) 
This will give guidance for use of text styles 

 
Text Style Table 

(Values in the above chart are representative of a 1 to 1 scale) 
 

H.3  Dimension Styles and Settings 

MicroStation dimension styles allow you to save dimension settings by name. This 
allows for greater unity between groups of dimensions in the file, as several different 
styles can be used for various models or portions of a model. Dimension styles are 
managed through the Dimension Styles Settings dialog box.  

Text Style Font Height Width 
5 Point Text Tahoma 0.0042 0.0042 
6 Point Text Tahoma 0.005 0.005 

6 Point Text (Special Characters) Arial 0.005 0.005 
7 Point Text Tahoma 0.0058 0.0058 
9 Point Text Tahoma 0.0075 0.0075 
10 Point Text Tahoma 0.0083 0.0083 

10 Point Text (Survey Text) Arial Narrow 0.0083 0.0083 
10 Point Text (Existing Elevations) Monotype Corsiva 0.0083 0.0067 

12 Point Text Tahoma 0.01 0.01 
12 Point Text (Special Characters) Arial 0.01 0.01 

14 Point Text Tahoma 0.0117 0.0117 
14 Point Text (Property Owners) Bookman Old Style 0.0117 0.0117 

18 Point Text  Tahoma 0.015 0.015 
30 Point Text Tahoma 0.025 0.025 
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INDOT Dimension Styles 
As with Text Styles we have made significant changes to our Dimension Styles at 
INDOT.  The first change you will notice is the Dimension Styles Settings dialog box is 
different.  It gives the users more options and breaks the settings down into categories 
like Geometry, Units, and Text.  There is also a preview window at the bottom allowing 
you to preview the style prior to using it.  We have combined all of the old V8 Dimension 
Styles into 10 new styles (4 for full size sheets, 4 for letter size sheets and 2 for standard 
size sheets).  These Dimension Styles relate to the size of text and are linked to the 
appropriate Text Style.  The following tables will show you the settings for each 
Dimension Style.  
 

(See Appendix H for Dimension Style – Sheet Use chart) 
This will give guidance for use of dimension styles  
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Dimension Style Table 
 

Dimension  
Style  

Text Terminator Unit Label Format 

Arch 12 Point Text (Special Characters) Arrow Master Unit-Sub Unit 
Arch Ltr 6 Point Text (Special Characters) Arrow Master Unit-Sub Unit 
Arch Standards 9 Point Text Arrow Master Unit-Sub Unit 
Engr Arrow 12 Point Text Arrow Master Unit 
Engr Arrow Ltr 6 Point Text Arrow Master Unit 
Engr Circle 12 Point Text Circle Master Unit 
Engr Circle Ltr 6 Point Text Circle Master Unit 
Engr None 12 Point Text None Master Unit 
Engr None Ltr 6 Point Text None Master Unit 
Engr Standards 9 Point Text Arrow Master Unit 

 

H.4  Models 

A Model gives you the ability to store multiple independent sets of design data within the 
same file. (For additional information on models, see Section 2.4.1 -2.4.3 or chapter 6 of 
the V8 Update manual) 
 

(See Appendix H for Model – Sheet Use chart and proper model names) 
 
Model Properties 

   

 
 
 
 
 
 
 
 
 

Model Properties dialog box for Design (left) and Sheet (right) 
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Type 
Sets the model's type (Design or Sheet) and dimensionality (2D or 3D). 
 
Name 
Sets the model's name. 
 
Description 
Sets the model's description. 
 
Ref Logical 
Sets the Reference Logical name for the model. The logical name identifies the model 
when the DGN file is attached to another file as a reference (see the Reference 
Attachment Setting dialog box ). 
 
Annotation Scale 
The Annotation Scale icon displays the status of the Annotation Scale lock: on or off. 
When placing text, the lock must be on to ensure that text is placed at the defined scale. 
 
The option menu sets the scale for text and dimensioning in the model. You can select 
from a list of common scales, or select CUSTOM and input your own scale in the fields 
immediately to the right. You can also define custom scales the Scales.def file stored in 
the "..\Workspace\System\data" directory. 
 
Display Sheet Layout 
(Sheet Model only) If on, a sheet element will display in the new sheet model. 
 
Size 
(Sheet Models only) Sets the sheet size. Standard sheet sizes are available from the drop-
down menu, or you can select Custom and input your own size values in the H and W 
fields. The H and W fields are disabled when a standard sheet size is chosen. 
 
You can also define custom sizes in the scales.def file stored in the 
"..\Workspace\System\data" directory. 
 
Origin 
(Sheet Models only) Sets the origin of the sheet. 
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Rotation 
(Sheet Models only) Sets the rotation angle of the sheet, measured in degrees counter-
clockwise from the x-axis (horizontal). 
 
Can be placed as a cell 
If on, it is possible to place the model as a cell. (Should be checked by default) 
 
Cell Type 
Sets the cell type (Graphic or Point). This option menu is enabled only if Can be placed 
as a cell is on. 
 
OK 
Accepts the changes and closes the dialog box. 
 
Cancel 
Closes the dialog box without making any changes. 
 
Drawing Scale 
The Drawing Scale window is used to adjust drawing scale settings. These settings are 
particularly relevant to the process of creating sheet models for drawing production. 
 
To open the Drawing Scale window: INDOT>Common Tools>Model Drawing Scale 
 
Drawing Scale window  
The Drawing Scale window is a dockable window that contains controls for viewing 
and/or modifying working units, the annotation scale factor, and the Annotation Scale 
Lock.  

 

 

 

 Undocked Drawing 
Scale Window 

Docked Drawing Scale Window 
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The units that display in the Master Units and Sub Units option menus can be customized 
by editing the file "units.def". The scale factors that display in the annotation scale option 
menu can be customized by editing the file "scales.def" (do not attempt to edit this file). 
 
The selection of controls displayed in the Drawing Scale window can be customized by 
right-clicking in the window. The technique is the same as that for showing and hiding 
tools in tool boxes. 
 
Master Units (option menu) 
Sets the Master Units component of working units. 
 
Sub Units (option menu) 
Sets the Sub Units component of working units. 
 
Annotation Scale (option menu) 
Sets the annotation scale factor.  
 
Annotation Scale (Icon) 
Sets the Annotation Scale Lock. When this lock is on, the annotation scale is applied to 
any text that is placed in the model. 
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Scaling Definitions 
The following charts represent the scales defined in the scales.def file. 
The scales in this chart are to be used on metric sheets or imperial sheets (straight ratio) 
as well as metric base drawings when setting the annotation scale. 
Scale Name  Scale Factor Usage 
Full Size 1=1 1:1  
1:2 & 6"=1'-0" 2:1  
1:2.5  2.5:1  
1:4 & 3"=1'-0"  4:1  
1:5  5:1  
1:8 & 1/2"=1'-0" 8:1  
1:10 10:1  
1:16 & 3/4"=1'-0" 16:1  
1:20 20:1  
1:24 & 1/2"=1'-0" 24:1  
1:25  25:1  
1:30  30:1  
1:32 & 3/8"=1'-0"  32:1  
1:40  40:1  
1:48 & 1/4"=1'-0"  48:1  
1:50 50:1  
1:60 60:1  
1:64 & 3/16"=1'-0" 64:1  
1:96 & 1/8"=1'-0"  96:1  
1:100  100:1 1:100 and All MX Created Metric Sheets 
1:128 & 3/32"=1'-0" 128:1  
1:192 & 1/16"=1'-0"  192:1  
1:200 200:1  
1:250 250:1  
1:256 & 3/64”=1’-0” 256:1  
1:300 300:1  
1:384 & 1/32"=1'-0"  384:1  
1:400 400:1   
1:500 500:1   
1:1000 1000:1  
1:5000 5000:1   
1:10,000 10000:1   
1:25,000 25000:1  
1:50,000 50000:1   
1:100,000 100000:1  
1:250,000 250000:1  
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The scales in this chart are to be used on MX Created imperial sheets as well as MX 
imperial base drawings when setting the annotation scale. 
 
Scale Name Scale Factor Usage 
MX Sheet 1"=1'-0" 12:1 All MX Created Imperial Sheets 
MX base 1"=10' 120:1   MX base drawing 1"=10' 
MX base 1"=20' 240:1    MX base drawing 1"=20' 
MX base 1"=25' 300:1 MX base drawing 1"=25' 
MX base 1"=30' 360:1    MX base drawing 1"=30' 
MX base 1"=40' 480:1    MX base drawing 1"=40' 
MX base 1"=50' 600:1 MX base drawing 1"=50' 
MX base 1"=60' 720:1   MX base drawing 1"=60' 
MX base 1"=100' 1200:1   MX base drawing 1"=100' 
MX base 1"=200' 2400:1   MX base drawing 1"=200' 
MX base 1"=300' 3600:1 MX base drawing 1"=300' 
MX base 1"=400' 4800:1 MX base drawing 1"=400' 
MX base 1"=500' 6000:1 MX base drawing 1"=500' 
MX base 1"=600' 7200:1 MX base drawing 1"=600' 
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Reference Files and Models 
With the emphasis of the use of Models at INDOT it is very important to understand how 
they are used and can be referenced within a dgn (self referencing) and to another dgn 
and back (Cyclical referencing).   
 
Using References 
Elements in a reference display as though they were in the active model. Although you 
cannot manipulate the elements in a reference, you can snap to them and even copy them 
into the active model. 
 
The most common usage of references is in the creation of design compositions. Design 
compositions are used by engineers and other technical professionals to communicate 
through the visual content of their designs. 
 
To create a design composition using MicroStation, you build a design model consisting 
of a working collection of references used in the performance of particular engineering 
tasks. For example, you may attach as references a collection of survey points as a guide 
for placement of additional geometry. Reference attachments in a design composition are 
usually coincident. 
 

• It is sometimes convenient to refer to one part of a model while drawing in 
another area by attaching the active model to itself. 

• You can attach a redline file created using Bentley Redline to your model for 
reviewing purposes. 

 
Another common usage of references is in the creation of drawings for publication. This 
task is called drawing composition. Whereas a design composition is typically contained 
in a design model, a drawing is composed in a sheet model. 
 

• For more information about models, see section 2.4.1  
 

H.5  Attaching references 

The most common way to attach a reference is to attach it coincidentally, which means 
that the coordinates of the referenced model's design plane and optionally its Global 
Origin are aligned with those of the active model, without any rotation, scaling, or offset. 
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To attach a reference coincidentally 
1. From the File menu, choose Reference. (The References dialog box opens.) 

 
 

2. From the dialog box's Tools menu, choose Attach. Or In the Reference dialog 
box, right-click in the list box and choose Attach from the pull down menu. (The 
Attach Reference dialog box opens.) 

 

 
 

3. Select the DGN file that contains the model to attach as a reference and click 
ADD and then click OK.  (The Attach Reference Settings dialog box opens.) 
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4. (Optional) From the Model option menu, choose the model to attach. 
The default is the reference's master model. 

5. (Optional) (unless the selected model is already attached) In the Logical Name 
field, key in a brief name for the attachment. 

6. (Optional) In the dialog box's Description field, key in a description of the model. 
7. To align the reference with the active model with regard to both Global Origin 

and design plane coordinates, select Coincident - World in the Orientation list 
box. This option is available only when referencing a model in a DGN file. 
Or  
To align the reference with regard to design plane coordinates only, select  
Coincident in the Orientation list box. 

8. (Optional) In the Scale (Master:Ref) fields, define the ratio of the active model's 
Master Units to the referenced model's Master Units. For example: 

 
To set  Left  Right 
One active model master unit per referenced model master unit (the 
default).  1  1  

Five active model master units per referenced model master unit.  5  1  
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9. (Optional) (DWG workmode only.) Set the level for the reference to be attached. 
 

Since the same model can be attached many times, give the references logical names and 
descriptions that help you remember which reference is which. 

 

For further discussion on using reference manager please refer to Chapter 8 of the Bentley 
Institute Course Guide, MicroStation V8 XM Edition User. 
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Since the same model can be attached many times, give the references logical names and 
descriptions that help you remember which reference is which. 
 
Working with nested references 
When a MicroStation design file used as a reference has its own attachments, they 
become nested references. The links between these files can be maintained through many 
levels (depths) of nesting, so that if you open only one file, you can view the contents of 
many files. The individual references can be updated, and the changes will be shown in 
the master (or parent) file. When you attach a parent reference to your model and turn on 
live nesting, you can also control how many levels of nested references are attached to 
the model. 
 
To attach a reference with live nesting 

1. In the Primary tool box, click the References icon. (The Reference dialog box 
opens.) 

 

2. In the dialog box's tool bar, select the Attach Reference tool. (The Attach 
Reference dialog box opens.) 
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3. Select the DGN file that contains the model to attach as a reference, and click OK.  
(The Attach References Settings dialog box opens.) 

 
4. From the Nested Attachments options menu, choose Live Nesting. 

 
5. The Nested Attachments options are only available when the selected model has 

reference attachments. When the Live Nesting option is on, the hierarchical 
structure of any nested references are maintained when attaching the parent 
reference to a model. In MicroStation, a nested attachment is displayed only if the 
child reference does not have its Ignore Attachment When Live Nesting setting 
turned on (in the Attachment Settings dialog box), and the parent reference has 
Live Nesting enabled. 

 
6. In the Nest Depth field, enter a high value (for example, 10). 
 

Set the depth setting to a high number to include even the most deeply nested references.. 
Although the nested attachments will display in the view window, you will see only the 
parent reference in the References dialog box's list box. 
 
Nested Attachments 
Determines if referenced models attached to reference models (and, so on) are recognized 
when a model is attached to the active model. 
 

• No Nesting — Models attached to the attached model are not recognized in the 
active model. 

• Live Nesting — Models attached to the attached model are recognized in the 
active model. 

• Copy Attachments — Models attached to the attached model copied into the 
active model. 

 
When working in a DWG or DXF file, live nesting is always on, and there is no limit to 
nest depth. Therefore the Nested Attachments and Depth items are disabled. To control 
the display of nested attachments, use the Ignore Attachment When Live Nesting setting 
(on the Attachment Settings dialog box). 
 
Nest Depth 
Sets the number of levels of referenced models that are recognized. Models can have 
their own referenced models, which, in turn, can have more referenced models, and so 
on. 
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If Depth is set to 0, only the model is attached to the master model; referenced models in 
the referenced model are ignored. 
 
MicroStation V8 includes the ability for live nesting of reference files.  Essentially this 
means that referencing a file causes its children (and potentially their children) to be 
automatically referenced as well.  
 
MicroStation allows two separate settings that control whether live nesting occurs. The 
first setting controls whether an attachment is displayed as a nested file. This setting is 
controlled through the "Ignore Attachment When Live Nesting" checkbox on the 
attachment settings dialog.  
 
The second setting is subtly different than the "Ignore/Overlay" setting discussed above.    
This setting controls whether children of a reference file are displayed at all and if they 
are displayed, the depth to which the children are nested.  
 
The difference is that the parent attachment controls whether the children are displayed 
rather than the children themselves controlling their nested display. In MicroStation, a 
nested attachment is displayed only if the child does not have its "Ignore When Live 
Nesting" setting on AND the parent has live nesting enabled.  
 
At a quick glance it would seem that it would be possible to simulate MicroStation's 
parental control of nest depth by creating Overlays whenever a parent attachment disables 
live nesting. Unfortunately this is not possible. Consider the example below.  
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A MicroStation design file, a.dgn has a single reference, b.dgn that is attached as 
a standard attachment (not an overlay). In MicroStation it is possible to attach 

a.dgn as a reference and include the display of b.dgn (as in c.dgn) or to disable 
the display of children by turning off live nesting (as in d.dgn).  

 

Circular References 
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H.6  Levels and Level Filters 

Levels 
In the new unified workspace environment we have taken and combined the levels from 
all previous workspaces to eliminate redundancy and establish consistency throughout the 
agency.  The total number of levels is now well over 400.  Due to the large number of 
levels, we have developed filters to make it easier for each user to display only the levels 
needed for their section/job.   
 
Level Filters 
Filters are a useful way to group associated levels for the purposes of viewing or not 
viewing as a group. For example, you might have a DGN file with several hundred levels. 
Within these levels could be filters for different disciplines such as Bridge and Traffic. 
Within Bridge there might be levels for E Bridge, P Alignments, P Culvert etc. You could 
easily define a filter called Bridge that would show only levels that would be associated 
with Bridge work. 
 
Filters can be named, saved, and recalled as needed or defined on-the-fly for immediate 
one-time viewing using the Filter Row in the Level Manager dialog box. Filters can be 
turned on or off using the Level Display dialog box. Filters can be used to turn on or off 
levels across a model and all of its attached models.  
 
Levels can be filtered by a number of attributes such as filename, color, style, line 
weight, and level groups, to name a few.  
 
Here at INDOT we have defined filters for Bridge, Bridge Rehab, Standards, Survey, 
Traffic, and others and they are available for use in each of the seed files you will be 
shown in section 1.7 but they are stored and defined in the dgnlib. 
 
To display the levels that are defined in a filter select the Active Level filter button from 
the Attributes toolbar and select the filter of choice.  This will display those levels only 
and turn off all other levels in the dgn.  Note that the levels will not actually be turned on 
or off, but the ability to view them in the Level Display will be dictated by the filter 
selected.   
 
See the following figure for a list of the available filters and sub filters. 
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H.7  Design File Settings 

Under Settings> Design File you will see the following screen 

 

Active Angle 
Sets the Active Angle — the angle, in degrees, used with tools that require an angle 
specification, including the Place Line, the Place Active Cell, the Place Text, the Rotate, 
and the Construct Array. 

Active Scale 
Consists of controls that are used to set the active scale factors and to toggle Scale Lock. 

Axis 
Consists of controls that are also available in the Locks dialog box. (Settings menu > 
Locks > Full). 
 
Axis Lock: If on, each data point is forced to lie at an angle (or multiples of that angle) 
from the previous data point. The angle is specified by the (Axis) Increment relative to 
the (Axis) Start Angle. 

Color 
Consists of controls that are used to modify the color settings in the elements and the 
dynamic X pointer. 
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Coordinate Readout 
Consists of controls that are used to set the format and accuracy with which coordinates, 
distances, and angles are displayed in the Status Bar, dialog boxes, and the Tool Settings 
window. 

Element Attributes 
Color, line style, line weight, class, level, and fill.  

Fence 
Consists only of a control used to set the fence selection mode. 

Grid 
Consists of controls that are used to set Grid Lock and the grid's spacing and 
configuration. 

Grid Lock  
If on, each data point is forced to lie on the grid. 

Isometric 
If on, each data point is forced to lie on the Isometric Plane. 

Locks 
Consists of controls that are also available in the Locks dialog box. 
 
Text Node Lock: If on, newly placed text is attached to empty text nodes, and you cannot 
place text if there aren't any empty text nodes. 
 
Level Lock: If on, you can select elements only on the Active Level; you cannot 
manipulate elements that are not on the Active Level. 
 
Graphic Group: If on, any manipulation performed on one member of a graphic group is 
automatically performed on all members. 
 
If off, the member elements of a graphic group can be manipulated individually. 
 
Boresite: (3D only) If on, you can select or snap to elements at any depth in the view 
cube. 
 
If off, you can select (with a data point) only those elements that are at or very near the 
Active Depth. Still you can snap to elements at any depth. 
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ACS Plane: (3D only) If on, each data point is forced to lie on the Active ACS's xy plane 
(z=0). Still you can snap to elements at any depth. 
 
The Active ACS is set in the Auxiliary Coordinates System dialog box, which is opened 
by choosing Auxiliary Coordinates from the Utilities menu. 

Rendering 
To edit rendering attributes. 

Snaps 
Consists of controls that are also available in the Locks dialog box. 

Association: 
If on, an association point is created each time an element is snapped to: Dimensioning 
tools, the Place Multi-line tool, the Place Active Cell tool or Use Shared Cell. 

ACS Plane Snap: 
(3D only) If on, and AccuDraw is active, the first snap point is forced to lie on the Active 
ACS's xy plane (z=0). 

Depth Lock: 
(3D Only) If on, each tentative point is projected along the view z-axis at the Active 
Depth. 

Stream 
Consists of controls that are used to set how data points are sampled while using the 
Place Stream Line String tool and the Place Point or Stream Curve tool. 

Stream Delta: 
Sets the minimum distance, in working units, between sampled points (vertices in the 
stream line string or curve).  
 
When the distance between the pointer's location and the previously sampled point 
exceeds the Active Stream Delta, the point is sampled and the Tolerance, Stream Angle, 
and Stream Area are applied to see if a data point should be recorded. 

Stream Tol(erance): 
 Sets the maximum distance, in working units, between recorded data points. The 
distance from the most recently recorded data point is checked for each sampled point. If 
that distance exceeds the active stream Tolerance, the sampled point is recorded as a data 
point. 
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Views 
To edit Pixel width and Height in the corresponding view. 

Working Units 
The units in which the current dgn is working in. 
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Seed Files – ( Template Documents) 
The following paragraph is quoted from the Bentley Institute Course Guide titled 
ProjectWise V8 XM Edition User. 
“A ProjectWise template is the same as a Microsoft template, or a seed file in 
MicroStation.  It is a file that is copied to create a new document.  You can use a 
document stored in ProjectWise or document that resides outside ProjectWise as a 
template.” 

 

All template documents are stored in ProjectWise Explorer, in the Template Documents 
folder.  Each set of seed files (Template Documents) resides within a sub folder 
describing their specific use. (Example:  MicroStation files are stored in the MicroStation 
folder). 

Documents\Template Documents 

 
 

MicroStation Seed Files (Template Documents.) 
Documents\Template Documents\MicroStation\ 
 
There are only two seed (Template Documents) that will be used on a regular basis. 

INDOT_Imperial_seed.dgn for imperial projects. 

INODT_Metric_seed.dgn for metric projects. 

Occaisionaly transeed.dgn will be needed for AutoCad files. 
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Microsoft Office Seed Files (Template Documents) 
When creating a new office document within ProjectWise Explorer, you will need to 
select the associated template document. 
 
EXCEPTION!!! -  When creating data tables to be linked into MicroStation use those in 
the folder labeled Spreadsheets (discussed next). 
 
Documents\Template Documents\Microsoft Office\ 
 
Access.mdb = Microsoft Access 
Excel.xls = Microsoft Excel 
MSProject.mpp = Microsoft project 
PowerPoint.ppt = Microsoft PowerPoint 
Publisher.pub = Microsoft Publisher 
Visio.vsd = Microsoft Visio 
Word.doc = Microsoft word 
 
Data Tables (Microsoft Excel Spreadsheets) 
To be used in conjunction with MicroStation.  Separate folders have been created for 
spreadsheets containing both imperial and metric units.  

Documents\Template Documents\Spreadsheets\Imperial-Drawing Spreadsheets\ 

Documents\Template Documents\Spreadsheets\Metric-Drawing Spreadsheets\ 

 

TB_APPROACH_ms.xls = Approach Table 

TB_BRIDGE_SUMMARY_ms.xs = Bridge Summary Table 

TB_DITCHES_ms.xs = Paved Side Ditch, Riprap ditch and Sodding Summary Table 

TB_EROSION_ms.xs =  Temporary Erosion Control Table 

TB_PIPEMATERIAL_ms.xls = Pipe Materials Table 

TB_ROAD_SUMMARY_ms.xls =Road Summary Table 

TB_SIGN_SUMMARY_ms.xls = Sheet Sign and Post Summary Table 

TB_STRUCTUREDATA_ms.xls = Structure Data Table 

TB_UNDERDRAIN_ms.xls = Underdrain Table 
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H.8  Structure of a V8 Design File 

We’ve had a number of requests from users for a chart that kind of shows the “structure 
of a design file” for an understanding of which settings are stored globally and which are 
stored with the model. The following image is only intended for learning purposes and is 
not a technical representation of the design file structure. 
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H.9  Cell Libraries 

 
X:\WRKSPC_INDOT_XM\Workspace\Standards\cell\... 
 
County.cel – All counties displayed as a “pop out” for the project location on title sheets.   
          All district “area” maps that can be used for title sheets. 
Pe_ls_stamps.cel – All Professional Engineers & Licensed Surveyors stamps. 
 
Details_eng.cel – Drawings for the detail sheets. 
Lighting.cel – Photometry templates. 
Patterns.cel – Area material patterns. 
Pavement_markings.cel – Traffic pavement markings. 
Signs_eng.cel – Road signs. 
Symbols_eng.cel – Various symbols for all groups. 
Table_legend_notes_eng.cel – Notes used for legends, tables, etc. 
 
Details_met.cel – Drawings for the detail sheets. 
Signs_met.cel – Road signs. 
Symbols_met.cel – Various symbols for all groups. 
Table_legend_notes_met.cel – Notes used for legends, tables, etc. 
 
 
Note:  “Thumbnails” of each cell can be found on the CAD/GIS FAQ Page. 
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Appendix I - Sheet use 

I.1  INDOT Border / Sheet Models 

A series of Sheet Models have been provided for use within the INDOT Workspace.  
These Sheet Models are to be imported into your DGN file within your project.  For a 
brief description of how to use this functionality see Chapter 3 of this document. 
These Sheet Models are stored within a DGN file located in the ProjectWise 
Environment at the location listed below. 
 
Documents\Template Documents\dgn\ 
 
Sheets_eng.dgn  =  For use with imperial projects. 
Sheets_met.dgn  =  For use with metric projects. 
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I.2  Sheet Name and Sheet Description 
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Appendix J - Scale Chart 
 
Metric English 
 Desired Scale True Scale 

(Master:Reference)  
(in border) 

12 Scale Factor 
(Master:Reference) 
(ft border) 

 1/16 in. = 1 ft 1 : 192 1 : 16 
 3/32 in. = 1 ft 1 : 128 1 : 10.6666667 
1 : 100 1/8 in. = 1 ft 1 : 96 1 : 8 
1  : 50 3/16 in. = 1 ft 1 : 64 1 : 5.33333333 
 1/4 in. = 1 ft 1 : 48 1 : 4 
 3/8 in. = 1 ft 1 : 32 1 : 2.66666667 
1 : 20 1/2 in. = 1 ft 1 : 24 1 : 2 
 3/4 in. = 1 ft 1 : 16 1 : 1.33333333 
1 : 10 1 in. = 1 ft 1 : 12 1 : 1 
1 : 50 1 in. = 5 ft 1 : 60 1 : 5 
1 : 100 1 in. = 10 ft 1 : 120 1 : 10 
1 : 200 1 in. = 20 ft 1 : 240 1 : 20 
 1 in. = 30 ft 1 : 360 1 : 30 
1 : 500 1 in. = 40 ft 1 : 480 1 : 40 
 1 in. = 50 ft 1 : 600 1 : 50 
1 : 1000 1 in. = 60 ft 1 : 720 1 : 60 
 1 in. = 100 ft 1 : 1200 1 : 100 
1 : 25000 1 in = 2000ft 1 : 24000 1 : 2000 
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Original Tip Date: May 2, 2005

Hate keying in a ° symbol? Well, good riddance with this tip!  

Brent James offers this great tip!

When digitizing new linework, you can replace the degree symbol ( ^) with a semi-colon ( ; ) when entering angles in AccuDraw.

For example:

N89^59'42"E can be entered as N89;59'42"E
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Original Tip Date: Feb. 16, 2001

Hate keying in a colon? Well, good riddance with this tip!  

Hate keying in a colon ( : ) to separate the feet from inches when using Accudraw?

Use a semi-colon ( ; ), an apostrphe ( ' ), or two periods ( .. ) instead!

Thanks to Bentley's Rudi Wells and John Frampton for these tips.

Note, what you can't see in the clip below is me entering .. for the semi-colon.

Related Tips:

Stop Calculating Decimal Feet When Wanting To Enter Inches

Hate Keying In A Degree Symbol Well Good Riddance With This Tip

Hate Keyin In Angle Quadrants Well Good Riddance With This Tip
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This Tip
Print this topic

Original Tip Date: May 2, 2005

Hate keyin in angle quadrants? Well good riddance with this tip!  

If you want to type

N89^59'42"E you can enter it as

N89;59'42"E

Brent James shares this tidbit!

When specifying quandrants for entering angles, you can use the following numbers:

NE = 1

NW = 2

SW = 3

SE = 4

You can leverage this information by typing the quadrant number, a space and then the degree value in the angle field of AccuDraw.

Add on this tip and look what you can do!

N89^59'42"E now becomes 1 89;59'42"

See also:

Hate Keying In A Degree Symbol Well Good Riddance With This Tip

Hate Keying In A Colon Well Good Riddance With This Tip
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CAD settings for Survey  
Settings Units and angles as desired. 

 
Select the working units category 

 
 
 
 
 
 
 
 



Adjust Accuracyas desired 

 
Adjust angles to DMS 

 
 
 
 
 
 
 
 
 
 
 



Mode to Bearings or Azimuth 

 
Select Place SmartLine from drawing task 

 
 



Using AccuDraw with Place Smart line 
Draw  in a drawing with Section corners or traverse points, or whatever. 

 
Using polar mode for AccuDraw we will enter distance and bearing, using the tab key to switch between 
fields.  Move the cursor in the direction of the desired line.  Pressing space bar will toggle between 
rectangular and polar entry mode. 
 
Distances can be entered in master units followed by sub units when separated by a colon. 
 Tip…use semicolon instead.  Such as 129:5 5/8 which would be 129 ft 5 and 5/8 inches. 

 



 
Typing the bearing as N45;00’00”E 
AccuDraw will show the degree instead of semicolon 

 
 
Press V after each segment is placed to reorient the compass to View rotation. 
Continue placing elements… 

 
 
 
 
 



Next we can Dimension the lines to show angles and distances. 

 
Select the Dimension style Label Bearing Distance 
Toggle the label line icon in the middle of the panel.  Also use association lock for the Dimensions 

 
Association needs to be set for the File as will in the lower right of the status area.  Changes to elements 
will be automatically reflected in the updated dimensions. 

 



Do a Save Settings, to have settings saved. 
 

 
Select each segment and then left click to place the text. 

 
Continue will other segments. 

 
Modify and bearings change…with association lock 
 



Changes to Annotation Scale will update the Dimension Text. 
Remember to Use the Drawings Scale Toolbar. 
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